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Digital Content Protection, L.L.C., a Delaware Limited Liability Company (“DCP”) 

Representatives: 

Stephen P. Balogh  James M. Burger, Esq. 

President  Counsel to Digital Content Protection, L.L.C. 

Digital Content Protection, L.L.C. Thompson Coburn LLP 

3855 SW 153
rd

 Drive 1909 K Street, NW 

Beaverton, OR 97006 Suite 600 

(503) 712-6272 Washington, DC 20006 

Stephen.P.Balogh@intel.com (202) 585-6909 

 jburger@thompsoncoburn.com 

ITEM B.  PROPOSED CLASS ADDRESSED 

Proposed Class 4: Audiovisual Works—HDCP/HDMI 

ITEM C.  OVERVIEW 

Petitioner/Commenter Andrew “bunnie” Huang (“Huang”) seeks an exemption to circumvent 

any High-bandwidth Digital Content Protection (“HDCP”) protected content steaming over a 

High-Definition Multimedia Interface (“HDMI”) to make any “noninfringing use” of that 

content.
1
 The Digital Millenium Copyright Act, 17 U.S.C. § 1201 (“the Statute”) does not 

authorize the Librarian to grant such a broad exemption. The Statute permits exemptions only 

                                                 
1
 Petition of Andrew “bunnie” Huang for New Exemption Under 17 U.S.C. §1201 at 1 (“Petition”). 
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when a petitioner demonstrates a specific noninfringing use is adversely affected by a Technical 

Protection Measure (“TPM”).  

Huang has failed to specifically demonstrate how he is adversely affected in his ability to make 

noninfringing use of protected material. Although Huang provides a broad litany of supposed 

noninfringing uses, with one exception, he does not specify how he is adversely affected.
2
 While 

Huang refers to other users, no other users have specified how they are adversely affected by 

HDCP in their ability to make specific noninfringing use of protected content.
3
 Huang is only 

adversely affected in his ability to manufacture and sell his “NeTVCR”; a circumvention device 

he admits is prohibited.
4
 Finally, even for his example categories Huang fails to establish how 

HDCP adversely affects any noninfringing use. HDCP simply encrypts data that streams over an 

HDMI connection at the request of the source content’s TPM. HDCP does not know what type 

of content it is encoding, as it only processes a tiny sliver of the data in real time while that data 

is transmitted from a source to a display. Furthermore, HDCP does not impose any restrictions 

on the content’s use that are not otherwise imposed by the source TPM or by the capabilities of 

the source or viewing device; rather, HDCP protects the data at one particular step on the data’s 

journey from source to screen. Therefore, other than the functions performed by the NeTVCR, 

which would enable the copying and manipulation of content being transmitted via HDMI using 

HDCP, none of Huang’s categories of uses are actually prevented by HDCP itself.
5
 Rather than 

                                                 
2
 See Initial Comment of Andrew “bunnie” Huang Regarding Proposed Class 4 at 2-3 

(“Comment”). 

3
 The Free Software Foundation (“FSF”) filed the sole supporting Initial Comment. It similarly 

fails to meet the statutory criteria to specify noninfringing uses that demonstrably adversely 

affect a user’s noninfringing use. FSF flatly claims: “all users have a legitimate right to 

circumvent controls on audiovisual works, regardless of the medium or the particular use 

involved.” Its Comment further states: “The exemption should extend to all audiovisual works 

and all users, as well as to the sharing of tools needed to make circumvention possible.” FSF 

Initial Comment at 2. 

4
 17 U.S.C. § 1201(a)(1)(E) (2017). Complaint for Declaratory & Injunctive Relief ¶¶ 90–93, 

Green v. U.S. Dep’t of Justice, No. 16-cv-1492 (D.D.C. July 21, 2016) (“Complaint”). 

5
 Even with respect to the functions of the NeTVCR, as discussed infra, they are available in 

DVRs today – except recording high value content in the clear where prohibited by the source 

TPM. 
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request the exemption of particular TPMs which may have an impact on particular uses, Huang’s 

proposal targets a method of securely transporting content from one device to another, which has 

played a critical supporting role in facilitating the growth of the digital content distribution 

ecosystem.   

ITEM D.  TECHNOLOGICAL PROTECTION MEASURE(S) AND METHOD(S) OF CIRCUMVENTION 

HDCP is licensed by DCP, and was developed by Intel Corporation.
6
 HDCP is a link technology. 

HDCP protects high-value digital motion pictures, other high-value video programs (e.g., pay-

per-view or subscription video), and audio against unauthorized interception and copying 

between a digital set top box or digital video recorder (a “Source Device”) and a digital TV or 

other display (a “Sink”).  

While HDCP encrypts content for transit over HDMI, other TPMs are responsible for encrypting 

content at its source. For content available on physical media, TPMs such as the DVD Content 

Scramble System (“CSS”) or the Advanced Access Control System for Blu-ray (“AACS”), 

encrypt and store the entire work. For online sources, Internet streaming services protect their 

content using an encryption service such as Hypertext Transfer Protocol for secure 

communication (“HTTPS”).
7
 When a user instructs the Source Device to play content protected 

by such a storage or streaming TPM, the Source Device decrypts and decompresses the content 

in preparation to transmitting it to another device.
8
 That Device is often a display, such as a high-

definition TV (the Sink). If the source TPM requires link protection, HDCP authenticates the 

Sink. Then HDCP encrypts only small portions of the decrypted-decompressed content at a time 

when that portion is prepared for transmission across an HDMI connection to the Sink (an 

HDTV). The Sink then decrypts each portion when received. If it has the capability, the Sink can 

manipulate the content, e.g., provide picture-in-picture, overlay with different content, etc. (for 

more detail see Exhibit A). HDCP is agnostic as to the content. It doesn’t know anything about 

                                                 
6
 DCP is a wholly owned subsidiary of Intel Corporation. 

7
 See HTTPS Definition, TechTerms (October 10, 2008), https://techterms.com/definition/https. 

8
 HDCP permits transmission to a licensed “Sink,” such as an HDTV, or “Repeater,” such as a 

Digital Receiver. 
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the content being transmitted. Because the content is decompressed and transmitted in portions,
9
 

circumventing HDCP to gain access to protected streams is a very inefficient method of 

accessing the content for Huang’s categories of “noninfringing uses;” except for his NeTVCR’s 

use to record a full copy of the high-value content in the clear.
10

 

ITEM E.  ASSERTED ADVERSE EFFECTS ON NONINFRINGING USES  

Huang’s Petition and Comment fundamentally misunderstand HDCP’s role in the content 

playback ecosystem. He has failed to demonstrate, let alone prove by “a preponderance of the 

evidence,”
11

 how “users ‘are, or are likely to be,’ adversely affected by the prohibition on” 

circumventing HDCP.
12

 The only adverse effect is on Huang’s trafficking activities: the inability 

to manufacture and sell his circumventing NeTVCR, without first licensing HDCP.
13

 Huang’s 

Comment only provides hypothetical categories of uses he claims are currently adversely 

impacted by an inability to circumvent HDCP. This type of proof by hypothetical does not meet 

the Librarian’s standard that petitioners show, by a preponderance of the evidence, that specific 

noninfringing uses are adversely affected by a prohibition on circumvention. Nevertheless, even 

these hypothetical uses are (or will be) permissible under (i) a renewed exemption, (ii) a new 

                                                 
9
 Compressed video becomes orders of magnitudes larger when it is decompressed. A Blu-ray 

movie compressed on a disc will be measured in tens of gigabytes. When decompressed it will 

be measured in terabytes of data. 

10
 See infra text accompanying note 15. Even the NeTVCR use is inefficient when an entire 

compressed copy is available at the source and legally available to copy in the clear. 

11
 Exemptions To Permit Circumvention of Access Controls on Copyrighted Works, 82 Fed. 

Reg. 49550, 49551–52 (proposed Oct. 26, 2017) (to be codified at 37 C.F.R. pt. 201) (“NPRM”). 

12
 17 U.S.C. § 1201(a)(1)(C). 

13
 An exemption in this proceeding cannot immunize violations of § 1201(a)(2) and (b), which 

would still prohibit Huang from building and selling a device that circumvents HDCP. See 17 

U.S.C. § 1201(a)(1)(E) (“Neither the exception under subparagraph (B) from the applicability of 

the prohibition contained in subparagraph (A), nor any determination made in a rulemaking 

conducted under subparagraph (C), may be used as a defense in any action to enforce any 

provision of this title other than this paragraph.”). 



DCP Opposing Comment  Proposed Class 4: Audiovisual Works–HDCP/HDMI 

5 

 

exemption (to the extent a petition satisfies § 1201(a)(1)(C)),
14

 (iii) by using a licensed device, or 

(iv) by using content transmitted in the clear (e.g., Digital TV).  

As a link protection, HDCP cannot provide the functionality necessary to implement any of 

Huang’s example uses; however, it will not prevent the implementation of these functions at the 

content’s Source or at the Sink (see below and Exhibit A). Like the Internet expression “bits are 

bits,” HDCP doesn’t know, and isn’t affected by, the type of work being transmitted. It could be 

video, audio, or even textual matter, i.e., any kind of digital data. HDCP would not prevent a 

Source from providing picture-in-picture functionality, or from overlaying videos with text or 

images, or from interfacing with security systems and research devices. If a Source did not 

provide this functionality, HDCP would not prevent a Sink, like a smart TV, from providing it. 

Because HDCP protects the stream, circumventing HDCP is the digital equivalent of pointing a 

video camera at the TV – many interactive features are lost. Therefore, circumventing HDCP is 

of limited importance for consumers. 

At any moment in time, an entire work is never available to be encrypted by HDCP. Instead, the 

technology receives a small “block of data” (a very few bits) from a Source Device which has 

decrypted and decompressed the content protected by another TPM.
15

 If the TPM specifies link 

protection, HDCP then encrypts the block and sends it across the HDMI connection to a Sink or 

Repeater. The receiving device decrypts the block and prepares it for display (or, in the case of a 

Repeater, for re-transmission to a display). Such preparation can include image processing 

                                                 
14

 DCP is not suggesting that any of the proposed new petitions satisfy the statutory 

requirements. 

15
 Displays require decompressed content in order to display video. But in order to store video on 

a disc or transmit it over cable systems, over-the-air, or over the Internet, the content is 

compressed. See Media Compression Definition, TechTerms (Apr. 8, 2011), 

https://techterms.com/definition/media_compression.  HDMI was designed to transmit 

decompressed data over a short link to a display. Although all the content Huang claims to wish 

to access and record on his NeTVCR is available compressed (albeit protected), his system 

would have to capture and circumvent the uncompressed HDCP-protected stream and 

recompress it for storage. 
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functions (e.g., picture-in-picture, image overlay, image enhancement, brightness adjustment, 

and so on).
16

  

Indeed, the only person who would be “adversely” affected by an inability to circumvent HDCP 

is Huang, who wants to manufacture and sell his NeTVCR, which, in his own words, “would 

circumvent HDCP technology to, among other things, allow people “to save content for later 

viewing, move content to a viewing device of the user’s choice, or convert content to a more 

useful format.”
17

 

This statement raises several significant issues in the context of this proceeding. First, Huang’s 

Petition and Comment fail to prove that any other “users” are adversely affected. The desire to 

traffic in a particular circumventing device is not such proof. Second, as below (and detailed in 

Exhibit A), if the originating TPM allows any of those functions, Huang can sign TPM and 

HDCP licenses to record to, and output the content from, his NeTVCR without circumvention. 

Indeed, at least one manufacturer and many Multichannel Video Program Distributors 

(“MVPDs”)
18

 are providing DVRs with much of this functionality today. 

Huang’s attack on HDCP is an attempt to avoid a proper analysis of what the original TPM 

permits or doesn’t permit.
19

 The correct venue for addressing that issue, as many users have done 

                                                 
16

 The HDCP license specifically permits both Sinks and Repeaters to temporarily store content 

in the clear for image processing (e.g., picture-in-picture, image overlay, image enhancement, 

freeze frame, etc.). See HDCP License Agreement, Ex. C at ¶ 3.2, https://www.digital-

cp.com/licensing. 

17
 NPRM at 38 (quoting Complaint, supra note 4). This is a puzzling strategy. As demonstrated 

in Exhibit A and discussed infra, there are DVRs on the market that record, platform and time-

shift compressed video without circumventing HDCP. Moreover, NeTVCR’s recompression can 

result in lower quality video due to errors introduced by recompression. See Shanawaz Basith & 

Stephen R. Drone, Digital Video, MPEG and Associated Artifacts, Surprise 96 Journal (June 14, 

1996), www.doc.ic.ac.uk/~nd/surprise_96/journal/vol4/sab/report.html. 

18
 MVPDs include traditional cable providers like AT&T, Comcast, and Charter, satellite 

providers like Dish Network, as well as next generation fiber optic cable and Internet providers.  

19
 Huang admits that much of the content he proposes to circumvent, when streamed protected by 

HDCP, is subject to other TPMs at the source.
 
Comment at 3: “. . . many videos and video games 

are only available in formats subject to TPMs . . . .” 
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in this Triennial, is to petition for an exemption to circumvent the original TPM for a 

demonstrable noninfringing use where users can prove they are adversely affected.
20

 If such a 

petition meets the statutory criteria, the Librarian will grant an exemption. On the other hand, 

Huang is asking for carte blanche to circumvent HDCP regardless of the work being transmitted 

across the link connection for any unspecified “noninfringing use.” Even if the Librarian had 

exemption power that broad, and the request was meritorious, such an exemption would not 

provide relief from liability for trafficking in a circumventing device such as the NeTVCR.
21

 

Huang’s Comment provides a laundry list of claimed categories of “noninfringing” uses in which 

Huang “and others seek to engage . . . .” The list is not exclusive but “includes” a recitation of 

general uses without demonstrating any specific adverse effects on users. The Comment also 

fails to demonstrate that such uses – to the degree they are noninfringing uses – cannot be 

accomplished today except by circumventing HDCP. Actually, with respect to some of the 

alleged uses, circumventing HDCP would not enable the uses (see below). Exhibit A provides 

more detailed evidence that Huang’s example uses can be accomplished today. The following 

summarizes that evidence. 

Political Expression – live political debates are broadcast free-to-air. Therefore, there are no 

legal or technical barriers preventing an Internet-enabled DTV receiver or smart TV from 

rescaling the video and inserting a blog alongside the debate. While HDCP protection would not 

be required for over-the-air content, if the debate were transmitted HDCP-protected from the 

Source Device to the smart TV, HDCP would not prevent a licensed Internet-enabled DTV from 

rescaling the video and adding a live blog.
22

 Furthermore, even for content which is encrypted, 

political expression is not dampened merely because it may not be possible to unilaterally insert 

commentary directly into the same screen as the content being displayed. There are myriad other 

                                                 
20

 If Huang were to ask for the same broad exemption to circumvent any other TPM for any 

noninfringing use, also unsupported by any evidence, we expect, as we do here, that he would be 

denied such a request. 

21
 See supra note 13. 

22
 As noted, the HDCP License specifically permits image enhancement. See supra note 16. 
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ways to comment on, critique and analyze news and information, which can reach viewers and 

members of the public quite effectively. 

Educational expression – Again nothing in HDCP prevents side-by-side comparison between 

two films. If the Source Device (e.g., set-top box) is capable of providing that functionality, 

HDCP will transmit the side-by-side comparison unaltered. If the Source Device doesn’t have 

that capability, circumventing HDCP would not enable such functionality as, by definition, the 

HDMI stream would consist of only a single video stream.  

News expression – Similarly, if the Source Device (receiver) has the capability, HDCP does not 

prevent simultaneous display of live coverage of one event by two news sources. HDCP is 

agnostic as to the content – it will simply transmit the two sources as stitched together by the 

Source Device DTV receiver. Like the previous example, this is puzzling because circumventing 

the single HDCP-protected HDMI stream would not provide this functionality – it would only 

yield the single stream decompressed in the clear. 

Safety expression – These functions are already being provided by some set top boxes and smart 

TVs today. HDCP, as a link technology cannot alter the content itself, but will transmit content 

that has been altered by the Source Device to include in informative overlay; or, as noted, HDCP 

permits a connected smart TV to provide these insertions.
23

 Nor are there any technical issues 

preventing such crawls as an overlay on live over-the-air DTV. To the extent that some safety 

services are not provided, lack of market demand is to blame, not lack of capability. 

Cultural expression – This is another puzzling example as most game consoles actively facilitate 

transmission or recording game play in the clear today. This type of functionality is extensively 

advertised and marketed. Users are currently transmitting game play over the Internet via 

YouTube, Twitch, and various device-specific platforms. 

Commercial expression – While clearly not fair use, there is nothing about HDCP that would 

prevent commercial substitution if the set top box or smart TV has that capability built in. 

                                                 
23

 See supra note 16. 
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The Comment lists a grab bag of “scientific research.” The Comment claims, without detailed 

explanation, such research requires “a corpus of video unencumbered by TPMs like HDCP.” 

Huang claims that these research functions would enable users, “to automatically generate 

subtitles, flag flashing imagery to protect viewers with epilepsy, analyze the proportions of lines 

spoken by different demographics, or identify content inappropriate for minors.” 

The Comment fails to provide a cogent explanation as why such “research” cannot be 

accomplished without circumvention or how HDCP prevents such “research.” There is no 

reason, for example, a smart TV or over-the-air or MVPD receiver could not be programmed 

process audio to generate subtitles (although unnecessary as the vast majority of such content 

already is subtitled), to filter flashing imagery, or to analyze dialog. Another example that Huang 

claims “cannot be achieved without circumventing HDCP” is “identif[ing] content inappropriate 

for minors.”
24

 Actually, one company – ClearPlay – is already providing software for use with 

TPM-protected content without circumventing those TPMs or HDCP. The ClearPlay solution 

doesn’t just identify inappropriate content, but permits parents to enable filters that skip over 

inappropriate content.
25

 

Finally, the Comment provides Huang’s real reason for wanting to circumvent HDCP: “to 

recapture the functionality of VCR machines that once allowed for time, format, and space 

shifting of ephemeral signals.” As demonstrated in Exhibit A, he is too late. Many of today’s 

Digital Video Recorders (“DVRs”) not only have “recaptured” VCR functionality, they have 

surpassed it. See Exhibit A for examples. For reasons of his own, Huang is unwilling to license 

the requisite source TPMs or, if they adversely affect noninfringing use, petition for an 

exemption of those TPMs, as have other participants in this 7
th

 Triennial. 

                                                 
24

 Petition at 3. 

25“
ClearPlay sells a fast-forwarding device which uses video time codes to permit customers to 

skip specific scenes or mute specific audio; it does not make copies of the films because the time 

codes are ‘integrated’ into the disc's encrypted content and players licensed to decrypt and play 

the content.” Disney Enters., Inc. v. VidAngel, Inc., 869 F.3d 848, 860 (9th Cir. 2017). 
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Fair Use 

Fair use is an important provision of the Copyright Act. But Huang simply relies on a blanket 

statement that “the uses above are transformative, fair uses that do not usurp the market for the 

original works, but achieve a new purpose.” Some uses maybe infringing, to the extent they are 

this conclusory claim, and the fair use discussion that follows, ignores the Supreme Court’s 

explicit call in Campbell v. Acuff-Rose Music, Inc. for case-by-case analysis of fair use claims 

based on four statutory factors: (1) the purpose and character of the use, particularly any 

commercial or educational use; (2) the nature of the copyrighted work; (3) the amount and 

substantiality of the portion used; and (4) the effect of the use upon the potential market for or 

value of the copyrighted work.
26

 A bare wholesale assertion of transformative use, without more, 

does not make a fair use. Thus, Huang fails to apply the Campbell transformative use test, which 

“focuses on whether the new work merely supersedes the objects of the original creation, or 

whether and to what extent it is ‘transformative,’ altering the original with new expression, 

meaning, or message.”
27

 

Many of Huang’s categories of uses, or potential uses within these categories, do not meet the 

Campbell test. The uses are not transformative. Neither adding commercials and subtitles to an 

audiovisual work, nor recording an entire protected-work in the clear, sufficiently alters the 

original work’s meaning or expression.
28

 Huang’s bare assertion that his broad categories of use 

are all transformative fails to meet first prong of the fair use analysis. He has not carried the 

burden of demonstrating transformative use for any of his non-exclusive, broad categories of 

uses. The Comment fares no better on the other three fair uses criteria. 

When applying the second factor, courts are instructed to give expansive protection to works that 

are “closer to the core of intended copyright protection,” and thus to more stringently apply fair 

                                                 
26

 510 U.S. 569, 577 (1994). 

27
 Id. at 570. 

28
 Comment at 2. 
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use protection.
29

 This core of protection includes works of fiction, motion pictures, and other 

creative works.
30

 A great many of the works protected by HDCP and transmitted over HDMI fall 

into these categories and deserve a high level of protection. HDCP protects data from motion 

pictures, video games, television shows, and multimedia presentations, each of which have a 

substantial fictional or creative component. The nature of the copyrighted works implicated by 

Huang’s requested exemption counsels strongly against a finding of fair use.  

The third factor similarly weighs against a finding of fair use. Given the streaming nature of 

HDCP-protected content, the broad categories of use for which exemptions are requested, and 

the capabilities of Huang’s NeTVCR, it is possible that the entirety of each work flowing over 

HDMI would be completely copied and made available in the clear. Indeed, Huang’s Complaint 

notes that his NeTVCR would allow users “to save content for later viewing, move content to a 

viewing device of the user’s choice, or convert content to a more useful format.”
31

 The fact that 

Huang intends his exemption to result in the proliferation of full, in-the-clear copies of protected 

content further raises the bar for a finding of fair use.  

Finally, the end result of circumventing HDCP would be an in-the-clear copy of entire works 

originally protected from infringing distribution. As history teaches, once a copy is available in 

the clear, massive online infringement is inevitable and the negative effect on the market for the 

work will be substantial. Granting Huang’s petition would provide a means by which in-the-clear 

copies of many protected works could be generated with little recourse for the content creators. 

Even if the Comment had provided a credible fair use analysis under Campbell, it would be 

unnecessary for the purpose of analyzing Huang’s request for an exemption. As demonstrated 

above, and in Exhibit A, HDCP does not adversely affect users’ ability to make any of the uses 

in Huang’s nonexclusive list. Moreover, DVR functionality is available for streaming media 

including over-the-air Broadcasts, cable and satellite transmission, even for Internet streaming 

                                                 
29

 Campbell, 501 U.S. at 586.  

30
 Id.  

31
 Complaint at ¶ 91. 
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video and game play, except where the source TPM prohibits copying. Whether or not the 

NeTVCR uses are fair uses, HDCP does not prevent any of these uses. Because HDCP is 

agnostic as to the content, even if a user is adversely affected by the source TPM’s copying 

prohibition, this overly broad request to exempt HDCP circumvention for any noninfringing use 

is inappropriate and beyond the Librarian’s authority. 

Statutory Factors 

(i) The availability for use of copyright works. 

The Comment’s logic is faulty. As noted above, HDCP does not prevent the use of video games 

and other videos. On many devices game play is not encrypted, just the game software – 

circumventing HDCP does not provide access to the game software. With respect to other 

videos, as demonstrated above and in Exhibit A, not one of those uses is adversely affected by 

HDCP. 

(ii) The availability for use of works for nonprofit archival, preservation, and educational 

purposes 

As noted, game play is available in the clear and can be recorded into “a more long-lasting 

format,” which format Huang does not specify. It’s not clear what other “ephemera” content, 

other than game play, the Comment is referencing. But because DVRs exist today that record 

over-the-air, streaming, and cable/satellite programming, the Comment’s assertion of the need to 

circumvent HDCP is without foundation. Moreover, to the degree source TPMs prevent 

“educational uses such as side-by-side comparison of films in a film studies class or educational 

overlays or real time commentary and analysis on a video feed,”
32

 educators will be able to do so 

under the existing/renewed education exemptions or new exemptions (to the degree they satisfy 

the statutory criteria). HDCP does not prevent any of the enumerated educational uses.
33

 

                                                 
32

 Comments at 5. 

33
 The Comment does not explain how HDCP prevents these educational uses. As noted above, 

circumventing HDCP will not enable uses like side-by-side comparison, educational overlays or 

real time commentary. See News Expression supra page 7. 
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(iii) The impact that the prohibition on the circumvention of technological measures 

applied to copyrighted works has on criticism, comment, news reporting, teaching, 

scholarship, or research; 

As demonstrated above, HDCP does not prevent any of these uses. HDCP is agnostic to what the 

bits represent. If the Source Device is capable of content filtering like ClearPlay’s system, for 

example, HDCP will not receive the filtered inappropriate audio or video and will not encrypt 

those segments for transmission. As above, virtually all of these alleged uses are available at the 

source. To the degree a source TPM prohibits any specific uses in the Comment’s broad 

categories, Petitioners have asked for renewed or new specific exemptions. Moreover, as noted, 

circumventing HDCP would not work to enable the Huang’s examples of these uses. 

(iv) The effect of circumvention of technological measures on the market for or value of 

copyrighted works; and 

Huang’s many examples of noninfringing uses that are supposedly adversely affected by the 

prohibition on circumventing HDCP are a smoke screen for his real goal: circumventing HDCP 

to record entire in-the-clear copies of high-value works on his NeTVCR. Once an entire copy of 

a work is available in the clear and placed on the Internet it is not unreasonable to argue the 

effect will be a substantial negative one. We support the concerns expressed by the Joint 

Commenters on the likelihood of harm to the value of their works. 

(v) Such other factors as the Librarian considers appropriate. 

The Comment’s requested exemption is beyond the authority of the Librarian to grant. It asks the 

Librarian to eschew the statutory mandate that exemptions may only be granted where a user 

demonstrates by a preponderance of the evidence that a TPM adversely affects her specific 

noninfringing use. Even if Huang had demonstrated an adverse effect on one or more of his 

examples, which he has not, the Librarian should not grant a blanket exemption for all 

unspecified noninfringing uses. 

Conclusion 

Huang’s Comment does not support the apparent goal of the instant petition. That goal is to 

exempt circumventing HDCP to capture any content streaming across the HDMI connection for 
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any noninfringing use. Such an exemption is beyond the authority granted to the Librarian in the 

Statute. Equally important, except for the function of recording all content protected by other 

TPMs in the clear, HDCP does not adversely affect the Petition/Comment’s proffered categories 

of claimed noninfringing use. Moreover, since the Statute does not permit exempting 

circumventing devices, even if a broad exemption were granted, it would not allow 

manufacturing and sale of Huang’s NeTVCR. Finally, as Huang admits, it is the source TPMs 

that allegedly prevent “recapture the functionality of VCR machines.” Therefore, grant of this 

exemption would render the rest of this Triennial’s video class petitions irrelevant as all the 

source TPMs at issue depend upon HDCP to protect the high-value content as it streams across 

the HDMI link. 

 

DOCUMENTARY EVIDENCE 

See Exhibit A attached to this form. 
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Among other things, the viability of Mr. Huang’s petition hinges on the absence of 
alternative technologies that can provide the functionalities described in Huang’s examples 
without circumventing HDCP. As the list below demonstrates, the vast majority of Huang’s 
example uses are already possible through the use of non-circumventing technologies.1

Though Huang may propose additional example uses that are not specifically enabled by 
the products below,2 this Exhibit demonstrates that current manufacturers and providers are 
capable of incorporating added functionality into their products without the need to circumvent 
HDCP. To the extent there may be some uses that are currently not provided for (for example, 
those posited in Huang’s “Commercial expression” category) it is because there is no consumer 
demand for these services, not because HDCP prevents any such use.    

Picture-in-Picture Display:

Huang claims, without circumventing HDCP, it would not be possible to watch a live 
political debate alongside the text of a commentator’s live blog, or to rescale two movies for 
side-by-side viewing, or to simultaneously display the coverage of a live event by more than one 
news source. However, these functions can already be accomplished in multiple ways. First, a 
user could employ separate devices to provide much the same experience; for example, a live 
political debate could be displayed on a television while a viewer simultaneously read a blog on 
a phone, tablet, or computer. Second, if a consumer wished to view two separate programs on the 
same screen, current smart TVs make this possible. See, e.g.:  

1. VIZIO TV: Picture in Picture / PIP / POP, VIZIO Support, 
https://support.vizio.com/s/article/Picture-in-Picture-PIP-POP?language=en_US (last 
visited February 12, 2018) (describing how to use the picture-in-picture function on a 
VIZIO smart TV) (attached herein as Exhibit A-1); 

2. Sony TV: Displaying Picture-in-Picture (PIP), Bravia i-Manual, 
http://docs.esupport.sony.com/imanual/NA/EN/hx750/c_pippap_uc_pip.html (last visited 
February 12, 2018) (describing how to use the picture-in-picture function on a Sony 
smart TV)  (attached herein as Exhibit A-2); 

3. Samsung TV: How to View Picture in Picture (PIP) in Samsung SUHD 4K Curved 
Smart TV JS9000?, Samsung Support (December 29, 2017), 
http://www.samsung.com/in/support/skp/faq/1092297 (describing how to use the picture-
in-picture function on a Sony smart TV) (attached herein as Exhibit A-3). 

1 This list is by no means exhaustive. The following are just a few examples found in a simple 
Internet search. 

2 As evident from this pleading, there is little to no evidence supporting Huang’s Comment. 
Huang should not be permitted to introduce “missing” evidence in the third round, reply 
comments. The NPRM states: “Reply comments should not raise new issues, but should instead 
be limited to addressing arguments and evidence presented by others.” NPRM at, 49558. 
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Huang further claims that circumvention of HDCP is necessary to allow educators to 
draw notes over the top of an image or video. The technology to enable this use already exists 
and does not require circumvention. For example, both the Microsoft Surface Hub interactive 
whiteboard and the SMART series of whiteboards allow users to “add notes to, and write on, 
virtually everything you can show on the board.”  

4. SMART Board: SMART Board 7000 series: write, SMART Boards, 
https://education.smarttech.com/products/7000-series (last visited February 12, 2017) 
(attached herein as Exhibit A-4); 

5. Surface Hub: View reports in Presentation mode on Surface Hub and Windows 10 
Power BI, Microsoft: Power BI (October 13, 2017), https://docs.microsoft.com/en-
us/power-bi/mobile-windows-10-app-presentation-mode (attached herein as Exhibit A-5). 

Integration of TV and Security Systems: 

In the “Safety expression” category Huang suggests circumventing HDCP would be 
necessary to “rescale a display so that text or visual overlay can appear alongside it to notify a 
home owner that a door is open.” This functionality is presently provided by several MVPD 
services, as well as by security companies like ADT.  

6. Xfinity Home Security: Xfinity Home Features, Xfinity.com, 
https://www.xfinity.com/learn/home-security/features (last visited February 12, 2018) 
(attached herein as Exhibit A-6);  

7. Samsung Smart TV: Julie Jacobson, ADT Pulse Adds Samsung Smart TV App, AirPlay, 
Home Health, CEPro: Security (Jan. 21, 2013), 
https://www.cepro.com/article/adt_pulse_adds_samsung_smart_tv_home_automation_ap
p_airplay_home_health/ describing a partnership between ADT and Samsung to provide 
a Samsung Smart TV App that would integrate with an ADT security system) (attached 
herein as Exhibit A-7); 

8. Verizon (service no longer offered): Verizon offered a similar service from 2011-2014, 
demonstrating that implementation of such a service is not prevented by HDCP. See 
Verizon drops Home Monitoring and Control Service, Fierce Cable (Feb. 10, 2014) 
https://www.fiercecable.com/cable/verizon-drops-home-monitoring-and-control-service
(attached herein as Exhibit A-8). 

Further, the ability of MVPDs to provide caller ID services that integrate with video 
services demonstrates that providers are capable of rescaling content and overlaying it with real-
time information about other devices in one’s home—and, importantly, can do so without 
circumventing HDCP. Should there be an increase in consumer demand for security systems that 
integrate with smart TVs or MVPD services, the market has demonstrated that it is 
technologically capable of providing these services. 
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9. Xfinity: Turn Caller ID On or Off on a Non-X1 TV Box, XFINITY support, 
https://www.xfinity.com/support/articles/settings-for-the-universal-caller-id-to-tv-app
(last visited February 12, 2018) (attached herein as Exhibit A-9);  

10. U-verse: Activate Caller ID for Phone and U-verse TV, AT&T e support, 
https://www.att.com/esupport/article.html#!/u-verse-voice/KM1040428 (last visited 
February 12, 2018) (attached herein as Exhibit A-10);  

11. Spectrum: Caller ID on TV, Spectrum, Get Help and Support, 
https://www.spectrum.net/support/tv/caller-id-tv/?domain-redirect=true (last visited 
February 12, 2018) (attached herein as Exhibit A-11);  

12. Verizon: Caller ID for Fios TV, Verizon support, 
https://www.verizon.com/support/residential/tv/programs-features/callerid (last visited 
February 12, 2018) (attached herein as Exhibit A-12). 

Recording and Streaming of Video Games 

In perhaps his most puzzling claim, Huang states that HDCP prevents users from 
“recording a video gamer’s gameplay and remix[ing] it with audio and visual commentary about 
their game performance.” A quick search of any Internet video site would demonstrate this is not 
true. In fact all major gaming devices and computer operating systems now have the built-in 
ability to record gameplay or stream it live online.  

13. Recording on Windows 10: Record Game Clips with Game DVR on Windows 10, Xbox 
Support, https://support.xbox.com/en-US/xbox-on-windows/social/record-game-clips-
game-dvr-windows-10 (last visited February 12, 2018) (describing how to record 
gameplay on a computer running Windows 10) (attached herein as Exhibit A-13);

14. Streaming on Windows 10 and Xbox: Broadcast Your Game With Mixer on Windows 
10, Xbox Support, https://support.xbox.com/en-US/games/game-setup/broadcast-game-
with-mixer-windows-10 (last visited February 12, 2018) (describing how to livestream 
gameplay from a device running Windows 10) (attached herein as Exhibit A-14);  

15. Recording on iOS: How to Use QuickTime Player, Apple Support (June 3, 2016), 
https://support.apple.com/en-us/HT201066 (describing how to record the screen on a 
device running iOS) (attached herein as Exhibit A-15);

16. Recording on iOS Mobile: How to Record the Screen on Your iPhone, iPad, or iPod 
Touch, Apple Support (Nov. 17 2017), https://support.apple.com/en-us/HT207935
(attached herein as Exhibit A-16);

17. Recording on Xbox: Capturing Game Clips and Screenshots, Xbox Support, 
https://support.xbox.com/en-US/xbox-one/console/capture-game-clips-and-screenshots
(last visited February 12, 2018) (describing how to record gameplay on an Xbox gaming 
system) (attached herein as Exhibit A-17);
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18. Streaming on PlayStation 4: How to Broadcast on YouTube Using Your PlayStation 4, 
Playstation.com (October 3, 2017), https://www.playstation.com/en-gb/get-help/help-
library/apps---features/playstation-apps---features/how-to-broadcast-using-youtube/
(attached herein as Exhibit A-18);

19. Recording on PlayStation 4: Uploading a Video Clip, PlayStation 4 User’s Guide 
http://manuals.playstation.net/document/en/ps4/share/videoclip.html (last visited 
February 12, 2018) (describing how to record and upload gameplay from a PlayStation 4) 
(attached herein as Exhibit A-19). 

VCR Functionality: 

Finally, Huang argues that “circumvention of HDCP is necessary to recapture the 
functionality of VCR machines that once allowed for time, format, and space shifting of 
ephemeral signals.” Yet again, Huang is behind the times. Numerous Digital Video Recording 
devices (“DVRs”) that do not circumvent HDCP are currently available to users and far exceed 
the capabilities of traditional VCRs. For example, the latest iteration of the TiVo DVR allows 
users to pause, rewind, fast-forward, replay, or slow down  live TV, to transfer a signal from one 
device to another, to record content (if allowed by the source TPM), to rescale a picture and 
overlay it with an info banner, and to configure personalize menus to better navigate through 
content. MVPDs like Dish Network, Comcast, and AT&T provide DVRs with similar time-
shifting and space-shifting capabilities. Additionally, many of these devices come with advanced 
voice control and enhanced closed captioning for users with visual or auditory impairments.  

20. TiVo Time Shifting: See Let the Fun Begin, TiVo Roamio Welcome Center, 
https://www.tivo.com/quick-links/welcome-center-roamio/let-the-fun-begin (last visited 
February 12, 2018) (describing the time-shifting capability of the TiVo Roamio) 
(attached herein as Exhibit A-20);  

21. TiVo Space Shifting: Beyond the basics of your TiVo Roamio DVR, TiVo Roamio 
Welcome Center, https://www.tivo.com/quick-links/welcome-center-roamio/beyond-the-
basics (last visited February 12, 2018) (describing the space-shifting capability of the 
TiVo Roamio) (attached herein as Exhibit A-21);  

22. TiVo Recording: TiVo Roamio OTA 1TB DVR, Tivo.com, 
https://www.tivo.com/shop/ota-detail (last visited February 12, 2018) (describing the 
recording capability of the TiVo Roamio OTA) (attached herein as Exhibit A-22); 

23. Dish Network (The Hopper) Time and Space Shifting: The Hopper. The People’s 
Choice, Dish.com, https://www.dish.com/equipment/dvrs/hopper/ (last visited February 
12, 2018) (attached herein as Exhibit A-23); 

24. Xfinity (X1 DVR) Time and Space Shifting + Accessibility: Xfinity X1 Features, 
Xfinity.com, https://www.xfinity.com/learn/digital-cable-tv/x1 (last visited February 12, 
2018) (attached herein as Exhibit A-24); 
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25. U-verse Time and Space Shifting: Using your DVR, AT&T Welcome Center, 
https://www.att.com/u-verse-welcome/tv/dvr.html (last visited February 12, 2018) 
(attached herein as Exhibit A-25); 

26. Cox (Contour 2 DVR) Time Shifting: Contour 2: DVR, Cox.com, 
https://www.cox.com/residential/education-center/tv/dvr.html (last visited February 12, 
2018) (attached herein as Exhibit A-26).  
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Picture in Picture / PIP / POP 

PIP stands for Picture In Picture. This allows you to be able to watch two separate inputs at one time. You will have 
one large picture with a smaller picture inside of it. You can find a list of what inputs you can use together for PIP 
inside of your user manual. 

POP stands for Picture Outside of Picture. This is the same function as PIP only this allows you to see two inputs side 
by side instead of a smaller picture inside of the larger one. 

Not every model TV has PIP. Please check your user manual. 

The Picture in Picture (PIP) on VIZIO televisions works on multiple input sources. This means you need a signal or a 
device connected to more than one input on the television and have both inputs selected to display the information. 
Here is an example: You have an HD cable box connected to your television and you would like to have more than one 
channel displayed on the screen so you can watch two sporting events at the same time. You will need a coaxial 
splitter and two additional coaxial cables; these can be found anywhere home theater equipment is sold. Then follow 
these steps: 

1. Turn off both your cable box and television. 

2. Take the coaxial cable that comes OUT from the wall and connects to the IN of your cable box and disconnect it. 

3. Connect that cable to the IN on your coaxial splitter. 

4. Connect your two extra coaxial cables to the OUTs on your coaxial splitter. We will call them cable 1 and cable 2. 

5. Connect cable 1 directly to the DTV/TV input on your television. 

6. Connect cable 2 directly to the IN on your cable box, this will be the same connection you removed it from in step 
#2. Your HD cable box should still be connected to your television with an HDMI cable. 

7. Power on both the cable box and your television. Using the INPUT button on your VIZIO remote select the HDMI 
input connection where your cable box is located your cable box picture should come up on the Main screen. 

8. Press the PIP button on your VIZIO remote to bring up the small box in the corner. Press the PIP input button until 
you select the TV input and you should be ready to go. You may need to perform a channel scan with your TV tuner to 
locate all available channels before you do this step. In order to understand better how to perform a channel scan 
please check under the F.A.Q.s in the discussion area of your particular model television. 

In order to change channels in the small screen use the PIP CH - and + buttons located near the bottom of the 
remote. You can swap picture in the Main and Sub screens using the swap button and swap which screen will have 
audio by using the AUDIO button. You might notice an X next to some of the selections in the INPUT and PIP INPUT 
screens when you have PIP activated. That means that input selection is unavailable and cannot be used. For 
example, if you have the input TV selected on your main screen then if you press the PIP INPUT button and bring up 
that input menu you will see X's next to the TV and AV selections. The X's mean that when you have TV on the main 
screen you won't be able to use TV or AV on the small screen. Instead you would need to use any of the input 
selections that do not have an X next to them. 

PIP like this is not possible using any dish or satellite broadcasting as all of their signals must go through their boxes 
to be decoded. The television's internal tuner cannot handle those signals and turn them into anything viewable. If 
you are using satellite, contact them to see if they offer a set top box that does PIP on its own and doesn't need the 
television's help to accomplish it. 

If this does not resolve your problem please contact our technical support when you are in front of the TV and are able 

javascript:void(0);
https://support.vizio.com/s
javascript:void(0);
http://www.vizio.com/product-registration
https://support.vizio.com/s/user-manual-search
https://www.vizio.com/order-lookup/
https://support.vizio.com/VizioSupport_CustomerSRQStatus
http://www.vizio.com/store?country_code=US
javascript:void(0);
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Basic Operations Displaying picture-in-picture (PIP) 

Top Page  >  Watching TV  > Displaying picture-in-picture (PIP) 

Font Size i-Manual Print 

Parts Description 

Watching TV 

Using Other Devices 

Using “BRAVIA” Sync 
Devices 

Useful Functions 

Using Internet 

Using Home Network 
(DLNA) 

Configuring Various 
Settings 

Troubleshooting 

How to Use Bookmarks 

Overview 

You can watch two pictures (main and sub) simultaneously. The main picture can be displayed in full 
screen, and the sub picture can be displayed in an inset window (e.g. PC input and TV program). 

Steps 

1. Press the OPTIONS button. 

OPTIONS 

2. Select [Twin Picture] using the / buttons, then press the button. 
If the displayed source is other than the PC, select [PIP] using the / buttons, then press the 

button. 

3. Press / to switch audio output between the two pictures. 

To exit the PIP mode, press the RETURN button. 
To move the inset window 
Press the / buttons. 

Available Combinations of Two Pictures 

When the main picture source is a TV program, video input or component input, the sub picture 
source can be: 

- HDMI input (video format) 

When the main picture source is an HDMI input (video format or PC format), the sub picture source 
can be: 

- TV program 

- Video input 

- Component input 

When the main picture source is a PC input, the sub picture source can be: 

- TV program 

- Video input 

- HDMI input (video format) 

Notes 

If two pictures with different vertical frequency signals (e.g. a picture in full screen with 24p and a 
picture in an inset window with 60i) are displayed simultaneously, the smooth movement of the 
picture in an inset window may be lost. 

If [CineMotion] is set to [Auto 1], the smooth movement of the picture in an inset window may be lost. 

http://docs.esupport.sony.com/imanual/NA/EN/hx750/index.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index.html
javascript:void(0);
javascript:Write(85);
javascript:Write(120);
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_1_1.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_20_11.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_185_124.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_248_191.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_290_236.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_298_247.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_359_301.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_398_322.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_410_334.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/ts_preview.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/bookmark_intro_uc_la_kr.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/index_185_124.html


Trademark Information  List of Contents © 2012 Sony Corporation 

(For [Motionflow] compatible models only.) To remedy this, set to [Auto 2] or [Off]. Press the HOME 
button, then select [Settings] → [Picture & Display] → [Picture Adjustments] → [CineMotion] 
→ [Auto 2]/[Off]. 

Top of Page 

http://docs.esupport.sony.com/imanual/NA/EN/hx750/notices.html
http://docs.esupport.sony.com/imanual/NA/EN/hx750/onlinemap.html
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How to view picture in picture (PIP) in Samsung SUHD 4K Curved Smart TV JS9000 ? 
Last Update date : 2017.12.29 

PIP, also known as picture-in-picture, technology, you can view analog TV signals (air or cable inputs) while viewing an external video source like a DVD player, Set-top box, or 

PC. In order to activate PIP on your Samsung TV, you will need the original remote control that came with your television. 

CLICK HERE  to enable 3D in Samsung SUHD 4K Curved Smart TV JS9000. 

NOTE : While viewing video from an external device such as a Blu-ray player on the main screen, you can watch TV broadcast in a picture-in-picture (PIP) window. 

Navigate to Apps screen → Tap MENU/123 → Tap MENU icon → select Picture → Select PIP → Select On to activate PIP → select Close 

Pictorial representation of the above settings are as follows : 

1. Press MENU/123 button from the TV remote control. 

2. Select MENU as shown below. 

3. From the Menu screen, select Picture. 

http://skp.samsungcsportal.com/integrated/popup/FaqDetailPopup3.jsp?seq=1092298&cdsite=in&status=A


4. Scroll down and select PIP. 

5. Select PIP to activate or deactivate PIP. 

6. Select On to activate PIP. 

7. Then, select Close. 

8. Now you can see PIP enabled in your TV. 



Related Model Information 

UA55JS9000K, UA55JS9000R, UA65JS9000K, UA65JS9000R, UA78JS9500K, UA88JS9500K 

Contents Satisfaction Survey 

Q1. Is this content helpful? 

Yes No 

Q2. How satisfied were you with this content? 

Q3. Tell us what you think. What could we have done to answer your question better? 

SUBMIT 

How would you like to contact us for support? 

Email Support Phone Support Online Service Center 

If you have additional questions or require further assistance, please chat with our experienced technical team online.  Live Chat 
※ Our operation hours are 09:00 am to 9:00 pm from Monday to Sunday 

H 
SHARE 

Copyright © 1995-2017 SAMSUNG All rights reserved 

javascript:validCssCommentAnswer();
http://www.samsung.com/in/support/erms/
http://www.samsung.com/in/support/#contactus
https://cybersvc2.samsungcsportal.com/in/index?locale_id=en
http://livechat.support.samsung.com/LiveChat/customer/IN
javascript:void(0)
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SMART Boards 

SMART Board® 7000 series 
Inspire greatness 

SMART Board 7000 series is 25 years in the making, and all new. The 7000 series is the 
digital heart of your interactive classroom experience , connecting SMART Boards and 
software, devices and vibrant imaginations. It helps students discover talents and passions, 
and teachers to promote student achievement in exciting new ways. 

Download brochure 

Find reseller 

Everything just one-touch away. Thanks to iQ. 

https://home.smarttech.com:443/en
https://education.smarttech.com/en/products/smart-board-interactive-flat-panels
https://education.smarttech.com/en/products/smart-learning-suite
http://home.smarttech.com/interactive-displays-for-business
https://education.smarttech.com/products/podium-624
https://education.smarttech.com/en/products/accessories
https://home.smarttech.com:443/en/services
https://home.smarttech.com:443/en/services/education-consulting
https://training.smarttech.com:443/en
https://home.smarttech.com:443/en/business/services
https://home.smarttech.com:443/en/services/community
https://support.smarttech.com:443/en
https://education.smarttech.com/en/products/notebook/download
https://support.smarttech.com:443/en/downloads
https://training.smarttech.com:443/en
https://support.smarttech.com:443/en/contact-support
https://home.smarttech.com/where-to-buy?sector=education
https://home.smarttech.com/where-to-buy?sector=business
https://education.smarttech.com/en/products/smart-board-interactive-flat-panels
https://education.smarttech.com/en/products/7000-series
https://education.smarttech.com/en/products/6000-series
https://education.smarttech.com/en/products/2000-series
https://education.smarttech.com/en/products/compare
https://home.smarttech.com/special-offers-for-education
https://downloads.smarttech.com/media/sitecore/en/pdf/products/ifp/ed-ifp7000-factsheet-en.pdf
https://home.smarttech.com/where-to-buy?sector=education


iQ technology lets teachers switchfrom SMART Notebook lessons to whiteboard to 
game-based activities and more – right at the board. 
Students stay focused. Teachers save precious  .  time 

Where classroom technology comes together 

SMART Board 7000 series is a classroom technology hub for learning software, lesson 
content and student devices. 

One-year SMART Learning Suite  subscription included. 

https://www.youtube.com/watch/?v=L64XamYj9ME
https://education.smarttech.com/products/smart-learning-suite
https://education.smarttech.com/products/smart-learning-suite


fley. w.. 
iJ \1J 

rp.e. Scrc.s.lara. 
0 

=  0. 

(x)=4P. 1;6); pi(dx .7e,(x)-17:0, sinOcos' 2nrchf; o,s 
n   

e- - 
L'  .0 

• • 
• • 

0 

Yi 

r2y ,,  xy / .. (X  .1 )̀y ,O. 

Kn(x)  =  22
.

1.  •  1-17(4—  4°) c. 
n.z4  

• 

k•Sin nn L  

y (iy, 4  1
42 

Z  1„

..

/e  -45 d'  

ov

, 

x

g e 11)("46f,Y2 NY, KO 11 642  (igdf
.  



Only with SMART Board 7000 Series 
Revolutionary features that raise the 7000 series experience a level above. 

WRITE 
The SMART Board 7000 series frees student imaginations to run wild. 

Students and teachers can add notes to, and write on, virtually 
everything you can show on the board as easy as paper. 

Teachers see four different answers written at the same time with Pen 
IDTM. 

SMART inkTM  lets you write over websites, videos, PDFs and Microsoft 
Office® files and save your notes in almost any file type. 

Capture screens. Change ink colours. Use presentation tools. Convert 



writing to text. SMART inkTM  gives teachers one-touch access to these 
features and more. 

Smooth writing experience produces lines with curved edges that look 
real. 

The SMART Board 7000 series comes with four pens, so it’s easy for 
students to work side by side on projects. 

Hands-On Learning 
Only available on SMART Boards, Simultaneous Tool Differentiation frees students to 
work together on a group project or complete separate tasks at the . same time 
Everyone is able to jump in using pens, erasers and fingertips. 

TOUCH 
What if students didn’t have to take turns? Creating together is super 
easy and really fun when different students can move objects, type on 

the screen and tap to select at the same time. 

An ultra-smooth SilktouchTM  finish allows teachers to use the board fo 
hours without finger burn. 



16 simultaneous interaction points let many students do different thin 
at the same time with pens, erasers and fingers. 

Fingers select. Pens write. Palms erase. Your SMART Boards 
automatically know the difference thanks to Object awarenessTM. 

SHARE 
Spark classroom discussions. Uncover hidden talents. Inspire 

greatness. The SMART Board 7000 series connects everyone and 
everything inside an immersive classroom experience. 

Share any device Android, Apple and Windows device with the board. 

No apps. No cables. No extra computers. An all-new wireless 
experience is perfect for BYOD lessons. 

Every lesson and presentation looks crystal clear in 4K Ultra HD 
resolution. 

iQ technology makes it really easy for students and teachers to share 
everything with the class. 

Easy to afford. Even easier to use. 
Training, maintenance and energy costs are big expenses. We want to 

help stretch your technology budget and lower the total cost of 
ownershipover your SMART Board’s lifespan. 

We pioneered Accelerated Life Testing to ensure less downtime and 
longer life. 

SMART Boards are one of the few to earn  an ENERGY STAR® 
certification  for energy efficient design. 

Technology that’s easy to use gets used. Intuitive design increases 

https://home.smarttech.com/about-us/environmental-commitment/energy-star


teacher adoption and reduces training time. 

Presence detection cameras automatically turn the panel on and off 
when you walk in or leave the room, saving you energy and extending 
the life of your display. 

Your 7000 series panel comes with a 3-year warranty (5-years for the 
United Kingdom), and a 1-year warranty on pens. 

Automatic, over-the-air software and firmware updates with every new 
release save your IT department tons of time. 

Commercial-grade SMART Boards are rated for 50,000 hours and 
provide years of dependable use. 

Fully heat-tempered glass is not only the safest option, but it can also 
stand up to the roughest classroom use. 

SMART Boards have received many safety, regulatory and 
environmental certifications, giving you peace of mind that the 7000 
series adheres to government or other regulatory requirements. 

Download Specs (75”) 

Compare SMART Boards 
Find the right model for your school. 

SEE CHA RT 

http://www.smarttech.com/kb/171133
https://education.smarttech.com/products/compare


Run your Notebook lesson from your mobile device 

Now you can circulate in the classroom while running your 
lesson on the SMART Board. Simply download the free SMART 
Notebook Playerapp, share your lesson to any SMART Board 
with the iQ feature and run it from your smartphone or tablet. 

SOFTWARE 
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TRAINING AND SERVICES 

ADDITIONAL HARDWARE 

INTERACTIVE DISPLAYS 

Questions? Ready to order? Get in touch. 

To speak with a SMART representative, please call  1-800-260-9408  
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Power BI Products Solutions Partners Learn Sign in 

Docs  /  Power BI   Power BI Desktop 

 

 Feedback Share | Theme Power BI Mobile Apps 

  Get started 

  All mobile apps 

  iPad app (Power BI for 
iOS) 

  iPhone app (Power BI for 
iOS) 

  Power BI app for Android 
phones 

  Power BI app for Android 
tablets 

Power BI app for Windows 
10 devices 

Get started with the 
Power BI mobile app for 
Windows 10 

View Reporting Services 
mobile reports and KPIs 
on the Power BI mobile 
app for Windows 10 

Pin a Power BI tile or 
dashboard to the Start 
screen 

View Power BI in 
presentation mode on 
Surface Hub 

  Power BI Developer 

  Power BI Report Server 

  Resources 

View reports in presentation mode on 
Surface Hub and Windows 10 - Power B 

 10 / 13 / 2017 •   2 minutes to read • Contributors 

In this article 

Display dashboards, reports, and tiles in full-screen mode 

Turn on presentation mode for Surface Hub 

Display and draw on reports on Surface Hub 

Next steps 

You can display reports in presentation mode on Surface Hub, and display dashboards, 
reports, and tiles in full-screen mode on Windows 10 devices. 


 

Presentation and full-screen modes are useful for displaying Power BI at a meeting or 
conference, or on a dedicated projector in an office, or even just for maximizing space on a 
small screen. 

with different colors of ink and navigate between the pages of the report 

Sign up fr ee  

In full-screen mode in the Power BI mobile app, 
menu bars is removed, except the page tabs and 

When you display a report in presentation mode 
  Download PDF 

all the "chrome" such as the navigation and 
filter pane in reports. 

on Surface Hub, you can draw 

Light 

YES 

Is this page helpful? 

NO 

https://www.microsoft.com
https://powerbi.microsoft.com
https://powerbi.microsoft.com/get-started
https://app.powerbi.com/?noSignUpCheck=1
https://github.com/maggiesMSFT
https://github.com/guyinacube
https://docs.microsoft.com/en-us/
https://docs.microsoft.com/en-us/power-bi/
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with different colors of ink and navigate between the pages of the report. 

You can also  display dashboards and reports in full-screen mode from the Power BI serviceon 
the web. 

 Note 

Presentation mode is different from  focus mode for tiles   . 

Display dashboards, reports, and tiles in full-screen 
mode 

1. In the Power BI mobile app on a dashboard, report, or tile, tap the Full screenicon 
to go to full-screen mode. 

2. In presentation mode, you can filter a report, or search for other dashboards and 
reports. 

Expand the Filters pane to set or remove filters. 

Tap the search icon to look for other dashboards. 

https://docs.microsoft.com/en-us/power-bi/service-fullscreen-mode
https://docs.microsoft.com/en-us/power-bi/mobile-tiles-in-the-mobile-apps


3. To exit full-screen mode, tap the icon with two inward-facing arrows on the toolbar, 

or swipe down from the top and tap the two inward-facing arrows . 

Turn on presentation mode for Surface Hub 
Presentation mode is on by default in Surface Hub, but if it's turned off, you can turn it back 
on. 

1. Tap the Settings icon at the bottom of the left navigation bar. 

2. Tap Options, then slide Enable Microsoft Surface Hub presentation modeto On. 

Display and draw on reports on Surface Hub 

1. In a report, tap the Full screenicon to go to Surface Hub presentation mode. 

You see a collapsible action bar on both sides of the screen. 

To open it, swipe in or tap the handle. 
To close it, swipe out or tap the X at the top. 

2. On devices that support writing with a pen, you can start writing immediately. 

3. To change the ink color, tap the pen in the left or right action bar. 



4. Tap the eraser or the undo arrow to remove some or all of the ink. 
5. Tap the circular arrow to refresh the report content. 

6. Tap the sideways arrows to go to other pages in the report. 

7. To exit full-screen mode, swipe down from the top and tap the two inward-facing arrows 

. 

Next steps 
Display dashboards and reports in full-screen mode from the Power BI service 
Questions?  Try asking the Power BI Community 

0 Comments 

Sign in 1 person listening 

+ Follow Post comment as... 

English (United States) Previous Version Docs  •  Blog  •  How to contribute  •  Privacy & Cookies  •  Terms of Use  •  Feedback  •  Trademarks 

https://docs.microsoft.com/en-us/power-bi/service-fullscreen-mode
http://community.powerbi.com/
https://docs.microsoft.com/en-us/locale?target=%2Fen-us%2Fpower-bi%2Fmobile-windows-10-app-presentation-mode
https://docs.microsoft.com/previous-versions/
https://docs.microsoft.com/teamblog
https://docs.microsoft.com/contribute
https://privacy.microsoft.com/en-us/
https://docs.microsoft.com/en-us/legal/termsofuse
https://aka.ms/sitefeedback
https://www.microsoft.com/en-us/legal/intellectualproperty/Trademarks/EN-US.aspx
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Connected and protected 
XFINITY HOME FEATURES 

XFINITY Home Features Our Partners Equipment 

Protect your family and home and look after them from anywhere with an Internet connection 
using your smartphone, tablet or computer, with XFINITY Home. 

AROUND-THE-CLOCK SECURITY 

24/7 peace of mind from anywhere 
Set rules to get real-time notifications of activity in your home like when doors or windows are 
opened, or when motion is detected. Feel confident knowing you’re connected, and protected, 

with XFINITY Home. 

Learn About Safety and Security 

24/7 Professional Monitoring Battery and Cellular Back-up Real-time Alerts 

Get peace of mind with professional Stay connected during power failures or Customize rules to get notifications of 
monitoring with fast response time. interruptions with battery and cellular activity in your home from anywhere. 

back-up included. 

SMART HOME CONTROL 

Stay connected to your home 
from anywhere 
In addition to remotely arming and disarming your system 
with the XFINITY Home app, you can also look after and 
control your home from anywhere. With additional 
equipment, get live video monitoring so you can see that 
your kids got home safely, control your thermostat and turn 
on lights so you never come home to a dark house again, 
and much more. 

Explore Remote Access 

https://www.xfinity.com/
https://www.xfinity.com/buy/
https://www.xfinity.com/learn/home-security
https://www.xfinity.com/learn/home-security/our-partners
https://www.xfinity.com/learn/home-security/devices
https://www.xfinity.com/learn/home-security/features/safety-and-security
https://www.xfinity.com/learn/home-security/features/home-automation


THE XFINITY INTEGRATION 

Access XFINITY Home from 
your TV 
Don’t get up! With XFINITY X1 and the X1 Voice Remote, 
use voice commands like “XFINITY Home cameras” to 
view live video monitoring, and more – all from the comfort 
of your couch and only with XFINITY Home. 

Learn About X1 And Voice 

VIDEO MONITORING 

Be in the know, even when you're 

See what’s happening in and around your home in real time with live 
video monitoring, included in your monthly XFINITY Home service; 
you’ll just need to add a camera to your system. For an additional 
$9.95/mo. per camera*, rewind, review and share up to 10 days of 
footage in the cloud with 24/7 Video Recording. 

*Taxes and fees extra. Pricing subject to change. 

away 

Learn About Video Monitoring 

https://www.xfinity.com/learn/digital-cable-tv/x1
https://www.xfinity.com/learn/home-security/features/video-surveillance


LIVE VIDEO LIVE VIDEO + RECORDING 

With a camera you can: 
24/7 live video monitoring 
Access anytime, anywhere 

With camera & recording you can also: 
Record, rewind and review up to ten days of 
footage 
Easily identify activity with motion events 
Download and share video clips 

$199
95 

$99
99 
 $995/mo*  + 

Video monitoring options 
Choose between a one-time camera purchase to unlock live video monitoring or get 50% off a 

camera when you add 24/7 Video Recording to your package. 

View Home Security Cameras 

*Pricing per camera for video recording plan. Taxes and fees extra. Pricing subject to change. 

AUTOMATION RULES 

Get real-time notifications 
Did the kids get home from school safely? Did the dog-walker come? 
Set rules to get real-time alerts when certain events happen, like when 
doors or windows are opened, or motion is detected. Personalize your 
alerts based off your family’s schedules and preferences. 

NOTIFICATIONS  THERMOSTATS LIGHTS 

   

ACCESSING YOUR SYSTEM 

Convenience and control at your fingertips 

https://www.xfinity.com/learn/home-security/devices/cameras


CONTACT US 

Get XFINITY Home new 

Speak with a specialist We'll call you 

1-877-591-2503 Schedule A Call Back 

SHOP XFINITY 

View all offers › 

36 USC 220506 

Easy-to-use mobile app Touchscreen controller XFINITY X1 
Download XFINITY Home App See Included Equipment Learn About X1 

SWITCHING AND MOVING 

Switch and upgrade to even more 
protection 
If you already have a home security system or move into a new home 
with one already installed, we can help. Our technicians could use and 
certify your existing equipment, and upgrade your system to the latest 
security and automation technology. 
*Use of existing equipment subject to conditions and type. System 
takeover currently not available in MA. 

SWITCH TO XFINITY  MOVING 

   

https://www.xfinity.com/support/home-security/download-xfinity-home-security-iphone-app/
https://www.xfinity.com/learn/home-security/devices
https://www.xfinity.com/learn/digital-cable-tv/x1
tel:+18775912503
http://www.xfinity.com/learn/home-security#9e6f8599-9d45-4713-a46d-b073818ce699
https://www.xfinity.com/learn/offers?lob=tv,internet,home
https://www.xfinity.com
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ADT Pulse Samsung Smart TV app at CES 
2013 

Photos & Slideshow 

 View Slideshow 

Security 

ADT Pulse Adds Samsung Smart TV App, 
AirPlay, Home Health 
At CES 2013, ADT showed Samsung TV app for home automation, integration 
with AirPlay for whole-house audio and home health monitoring. 

Julie Jacobson  · January 21, 2013 

ADT Pulse  has been gaining steam as a mass-market home 
automation solution, but it has been missing (at least) two 
important features available on more custom-oriented 
systems: a TV interface for security, lighting control, energy 
management and other controls; and integration with audio. 

At  CES 2013,  ADT showed both. 

On the TV side, ADT demonstrated a Samsung Smart TV App 
that puts the entire Pulse feature set on the big screen. 
Consumers can navigate the ADT interface via the handheld 
remote that comes with a Samsung Smart TV ... just as they 
would navigate Netflix, games and other Samsung Apps. 

When beckoned, the Pulse interface appears at the left of the 
screen, and the main TV event keeps on running, occupying 
about three-fourths of the real estate (currently there is no 
option for ADT Pulse to usurp the entire screen). 

The TV app is a big step for ADT. Currently the other solutions 
offered by mass marketers such as Comcast/Xfinity (with 
iControl), Lowe’s (Iris), 2Gig  and partners (Vivint, for example) 
and  Honeywell  (Total Connect) do not offer a TV interface. 

Of the mass marketers, the exception is  Verizon Home 
Monitoring and Control  (using the  4Home  platform), which 
offers a TV interface via FiOS. 

Although not yet widely distributed the  MiOS home automation platform  also provides a TV interface 
through a $50  TrickTV device and app. 

And of course, virtually all established, professionally installed home control systems offer TV GUIs. 

RELATED:  Why the Heck is ADT at CES 2013? 

Unlike some of the higher-end control systems, ADT Pulse cannot be configured at this time to 
automatically display screens based on an “event” such as a doorbell ringing. Ideally, users might want the 
TV to automatically display images from the front-door surveillance camera when someone rings the bell. 

It’s all manual currently: Go to Samsung Apps, pull up the Pulse app, click on cameras .... 

Still, it’s a start. In the next iteration, ADT plans to offer a voice-recognition feature so that the user can 
simply say, “Pulse ... front door ... door lock ... open,” says VP business development Greg Farrell. 

The second A/V showcase at the ADT booth at CES was the integration of AirPlay with Pulse. 

As Farrell says, “It’s just another app in Pulse.” 

In other words, you don’t have to leave the Pulse app environment to control your AirPlay tunes. 

https://www.cepro.com/
https://www.cepro.com/ceprotv
http://www.integratorjobs.com/
https://www.cepro.com/site/login/article/adt_pulse_adds_samsung_smart_tv_home_automation_app_airplay_home_health
https://www.cepro.com/site/register
https://www.cepro.com/site/newsletters
https://www.cepro.com/site/subscribe
http://www.ce-pro.eu
https://twitter.com/ce_pro
https://plus.google.com/u/0/118010347014147497563/posts
https://www.linkedin.com/groups/2443026
https://www.facebook.com/CEProMag
https://oasc05050.247realmedia.com/RealMedia/ads/click_lx.ads/cepro.com/842839570/Top3/default/empty.gif/592f556a505670794678454142435334?x
https://oasc05050.247realmedia.com/RealMedia/ads/click_lx.ads/cepro.com/L9/1417566082/Top/Ehpub/FIBBR_CEPro_Jan18/FIBBR_Lead_0102.gif/592f556a505670794678454142435334?x
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More ADT Pulse Partners: Energy Management and Home Health 
As  we wrote previously,  ADT exhibited at CES for the first time largely to showcase its open platform to 
potential partners. 

Although much of Pulse is based on a standard home automation platform from iControl, ADT is layering 
new solutions into the mix and inviting others to join the Pulse ecosystem. 

At CES, the company discussed its Advanced Metering Infrastructure (AMI) program with Southern 
California Edison, which is deploying smart meters to help customers better manage their energy bills ... 
and help the utility avoid blackouts and brownouts. 

The SCE meters utilize ZigBee, but the commands are bridged to Z-Wave in the home to communicate 
with Pulse. 

SCE is still just “looking at” time-of-use (TOU) pricing but for now the utility offers incentives for users who 
allow them to set back the thermostat on “Save Power Days.” 

Farrell explains, “Today, they might text you that it will be 106 degrees tomorrow and ask if they can auto-
set the thermostat to Save Power Day settings.” 

In addition to its energy management initiatives, ADT also is rolling out a complete home health solution. 
The provider already offers PERS (personal emergency response system) under the Companion brand, 
and has toyed with a complete home health service for seven or eight years. Now the company plans to 
deliver. 

At CES 2013, ADT announced a partnership with Ideal Life, which makes a number of medical monitoring 
devices for such conditions as diabetes, asthma, obesity and congestive heart failure. 

ADT will integrate these devices into its Pulse ecosystem so users (and their family and caretakers) can 
better monitor and respond to health conditions. 

MORE ON ADT PULSE HERE. 

Follow us on Twitter! 
@juliejacobson 
@ce_pro 

 About the Author 

Julie Jacobson, recipient of the 2014 CEA TechHome Leadership Award, is co-
founder of EH Publishing, producer of CE Pro, Electronic House, Commercial 
Integrator, Security Sales and other leading technology publications. She 
currently spends most of her time writing for CE Pro in the areas of home 
automation, security, networked A/V and the business of home systems 
integration. Julie majored in Economics at the University of Michigan, spent a 
year abroad at Cambridge University, earned an MBA from the University of 
Texas at Austin, and has never taken a journalism class in her life. She's a 
washed-up Ultimate Frisbee player currently residing in Carlsbad, Calif. Email 
Julie at  jjacobson@ehpub.com  
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Twitter  ·  LinkedIn  ·  Google+ 
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LinkedIn · Google+ 

View Julie Jacobson's complete profile. 
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Cable 

Verizon drops Home Monitoring and Control service 

Feb 10, 2014 4:13pm 

Verizon (NYSE: VZ) has stopped accepting orders for its Home Monitoring and Control product, and will only allow FiOS customers who already 
subscribe to the $9.99 monthly service to continue using it, a spokesman said Monday. 

Verizon introduced Home Monitoring and Control, which lets FiOS subscribers control security cameras, lighting, door locks and thermostats with their 
FiOS TV remotes, and through a mobile application and website, in 2011. It stopped accepting new orders in October, spokesman John Columbus told 
FierceCable. 

Rival AT&T (NYSE: T) launched a wireless-based home automation service last year called AT&T Digital Life, and Comcast (Nasdaq: CMCSA) and Time 
Warner Cable (NYSE: TWC) market their respective Xfinity Home and IntelligentHome products to broadband subscribers. 

Verizon officials suggested that the telco may introduce a new home automation product, but wouldn't say if the company is considering adopting a 
wireless-based approach similar to AT&T Digital Life. 

"We are revisiting the service to more accurately reflect our vision for the connected home. As technology and consumer expectations evolve so must 
our offerings," Columbus said. 

While Columbus said Verizon continues to provide support for existing Home Monitoring and Control customers, it has stopped selling new equipment to 
those customers, including security cameras, door locks and thermostats. 

When Verizon launched the service in 2011, it initially sold FiOS customers a $69.99 starter kit that included a security camera and a lighting module 
that could be used to control a single lamp. It increased the price for the starter kit to $90 in 2012, and in spring 2013, Verizon began to offer free, 
refurbished home automation starter kits to FiOS customers who agreed to add the $9.99 monthly service to their bundles. 

Verizon hasn't disclosed how many FiOS customers signed up for Home Monitoring and Control, or how much subscriber churn it has seen with the 
product. 

Related articles: 
Why Verizon Home Monitoring fails as a baby monitor but makes the perfect bug zapper 
AT&T rolls Digital Life home automation service in Comcast, Time Warner Cable, Cox markets 
Comcast 'dynamic ambient lighting' technology ties home theaters to smart light bulbs 
Comcast leads cable's push for cut of $13B home security and automation market 
Verizon shutting down FiOS Media Manager app for PCs, Macs 
Verizon, Motorola push home monitoring service 

Read More On 

https://www.fiercecable.com/
https://www.fiercecable.com/cable
https://www.addtoany.com/share#url=http%3A%2F%2Fwww.fiercecable.com%2Fcable%2Fverizon-drops-home-monitoring-and-control-service&title=Verizon drops Home Monitoring and Control service
https://www.fiercecable.com/#facebook
https://www.fiercecable.com/#twitter
https://www.fiercecable.com/#linkedin
https://www.fiercecable.com/#email
https://www.fiercecable.com/#print
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Support ⟩  Home Phone 

Search  Help & Support 
SIGN IN 

XFINITY COMCAST BUSINESS 

MY XFINIT Y SHOP/UPGRADE SUPPORT MY ACCOUNT 

Turn Caller ID on TV On or Off on a Non-X1 TV Box 
This article provides instructions on how to turn the Caller ID on TV feature on or off for 
customers that do not have XFINITY X1. 

For XFINITY X1 instructions, please read how  to setup X1 on-screen notifications. 

How it Works 
1. Press the Menu button twice on your Comcast remote to launch the Main Menu. 

If using the XR2 Remote Control, press the xfinity button twice instead of the 
Menu button. The xfinity button is a rectangular button situated in the center of 
the remote, above the Up arrow button. 

2. Navigate to the Interactive TV bar on the Main Menu. 

3. Press the OK/Select button on your remote control. You will see the Interactive TV 
Menu screen. 

4. Highlight Notifications , then press OK. 

5. Highlight the Caller ID option. 

https://www.xfinity.com
https://business.comcast.com/?utm_source=dotnet&utm_campaign=UniSlimNav0314SlimNavMYX&utm_medium=SlimNav
https://my.xfinity.com/?CMP=ILC_myxfinity_resi-help-and-support_re
https://www.xfinity.com/learn/offers?CMP=ILC_shop_resi-help-and-support_re
https://www.xfinity.com/support/?CMP=ILC_support_resi-help-and-support_re
https://customer.xfinity.com/Overview/?CMP=ILC_myaccount_resi-help-and-support_re
https://login.comcast.net/login?s=wnamp&ts=e57a12a7
https://tv.xfinity.com
https://home.xfinity.com
https://internet.xfinity.com/
https://connect.xfinity.com/voice
https://www.xfinity.com/mobile/
https://auth.xfinity.com/oauth/login?state=https%3A%2F%2Fwww.xfinity.com%2Fsupport%2Farticles%2Fsettings-for-the-universal-caller-id-to-tv-app
https://www.xfinity.com/support
https://www.xfinity.com/support/home-phone
https://www.xfinity.com/support/cable-tv/x1-text-messaging-notifications/


6. Use the left and right arrow keys on your remote to turn Caller ID On or Off. 

Notes: 

The Caller ID on TV application is currently not available in all areas. 
Additional selections on the Main Menu , Interactive TV Menu , and Notifications 
Menu may not be available in all areas or TV Box types. 

Relat ed Art icles 

Caller ID on TV Troubleshooting 

Set On-Screen Notifications on X1 

Didn’t find what you were looking for? 

Talk to an Agent 
et 

Chat with an Agent 
ha 

Visit an XFINITY Store 
Find a ser  e center 

Visit Our Help Communities 

Facebook  Twitter 

Forums Reddit 

https://www.xfinity.com/support/articles/universal-caller-id-error
https://www.xfinity.com/support/articles/x1-text-messaging-notifications
https://www.xfinity.com/support/schedule-callback
https://support.xfinity.com/chat
https://www.xfinity.com/support/service-center-locations
http://www.facebook.com/xfinity
https://twitter.com/XFINITY
http://forums.comcast.com/
https://www.reddit.com/r/Comcast_Xfinity/
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VIDEO 

Read article Close 

Loading ... 

Showing Content for MO |  Change your ZIP Code 

Support  >  Digital Phone  >  Voicemail & features  >  Calling features  >  Caller ID & Call Waiting  >  Activate Caller ID for Phone and U-verse TV 

Print 

Activate Caller ID for Phone and U-verse TV 
Subscribe to both Phone and U-verse TV and you can view the name and number of incoming callers on your TV 
before you decide to answer. 

INSTRUCTIONS  INFORMATION 

Set up Caller ID for U-verse TV  Set up Caller ID for U-verse TV 

article 

1 Go to  Overview  > My digital phone. 

2 Select My voicemail & phone features > Phone Features. 

3 Select Caller ID on TV. 

4 Select On or Off. 

5 Select Save. 

From your TV 

1 Tune your television to channel 9900. 

2 Under Settings, select Change Settings for Message Indicator and Caller ID 
Display. 

3 Select Display Caller ID with the arrow keys and select OK to add or remove a 
checkmark in the box. A checkmark indicates the feature is turned On. No check 
indicates it is turned Off. 

4 Select Back and Done to save your preferences. 

Additional information 
• You must subscribe to both Phone and U-verse TV for caller information to display on 

your TV. 
Chat available 



Phone calling features and star 
codes 

Customize your digital phone 
features to work for you. 

U-verse TV remote control 
troubleshooting tips 

Learn how to troubleshoot your 
U-verse TV remote control problems 
and issues. 

Caller ID Blocking for Phone 

Hide your name and phone number on 
outgoing calls with Caller ID Blocking. 

Chat available 

COMMUNITY DISCUSSION 

Visit the Phone Forums 
Get solutions to your voice issues. Post advice, too. 

  

Related solutions 

Did you get the help you needed? 

Yes No 

Go to forum 

• Caller ID is included with Phone at no extra charge. It’s part of your phone service and 
can't be deactivated. 

• If you're recording a program on your DVR when a Caller ID notification appears, the 
notification won't be recorded. 

• If you're watching a recorded program when a call comes in, it will display on your TV 
screen. 

• If you receive a call that has blocked its Caller ID, it won’t be displayed on your TV. 

COMMUNITY DISCUSSION 

Re: On screen telephone Caller ID Read post 

✔  Solved  by my thoughts u-verse-voice | Nov 10 2017 7:21 AM | 264 Views 

You cannot.... You can go to channel 9900 to view the call log, last 100 calls if I 

remember correctly. Plus ca  ...More 
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Related Articles 
Vishing and Caller ID Spoofing 
Nomorobo: Block Telemarketers 
and Robo-Callers 
Dropped Calls 
Can't Make or Receive Calls 
Spectrum Voice: Calling Features 

Related Videos 

Setting Up Spectrum TV App 
Spectrum TV 

 MENU 

Get Help & Support 

 

 

Popular Topics TV Internet Voice Account 
S 

TV 

 Caller ID on TV 
     Rate This   

Caller ID on TV (CIDTV) lets you see details of incoming and missed phone calls on your 
TV. There is no additional charge for Caller ID on TV when you subscribe to Spectrum 
Voice with Caller ID and Spectrum TV with a Spectrum Receiver (cable box). If you don't 
want to use this service, you can turn it off and manage Caller ID on TV settings with 
your Spectrum remote control. 

About Caller ID (CID) Popular Guides 

Requirements Spectrum Guide 
Features iGuide 
Troubleshooting Passport 

Note: Caller ID on TV is not available in the Southern California region (Los Angeles 
County) and is not compatible with analog receivers or CableCARDS. 

The content below explains basic information about Caller ID on TV. To find out how to 
use the feature on your receiver,  find your guide   and read the detailed instructions on 
how to use Caller ID on TV on your receiver. 

Requirements 
Digital TV Service 
Caller ID on TV is only available if you subscribe to a Spectrum Digital TV package. 

Spectrum Voice Phone Service 
Caller ID on TV is only available with select Spectrum Voice packages. 

Basic phone service does not qualify for CIDTV unless you purchased optional Caller ID. 

CIDTV only works with the primary phone number. TV call alerts do not appear for 
incoming calls on secondary phone numbers or distinctive ring numbers. 

Note: If you have more than one receiver, the CIDTV settings on each box are 
independent of each other. When the settings are changed on one receiver, the 
changes don't affect the other receivers. 

Top   

Features 
Caller ID on TV features vary based on which  interactive program guide  you have. The 
following features are available on all guides: 

Call Alert 
When an incoming call is received, the TV alert displays for several seconds, alternating 
between the caller's name and number, before disappearing automatically. 

If two calls are received around the same time, the most recent call will override the 
first call received. 

   

 

Ask Spectrum 

   

https://www.spectrum.net/
https://www.spectrum.net/support/
https://www.spectrum.net/support/
https://www.spectrum.net/support/category/tv/
https://www.spectrum.net/support/category/internet/
https://www.spectrum.net/support/category/voice/
https://www.spectrum.net/support/category/my-account/
https://www.spectrum.net/support/tv/spectrum-guide-settings-preferences-spectrum2/#/callerid
https://www.spectrum.net/support/tv/interactive-programming-guidemenu-arris-motorola-or-pace/#/CIDTV
https://www.spectrum.net/support/tv/interactive-programming-guidemenu-ciscoscientific-atlanta/#/CIDTV
https://www.spectrum.net/support/tv/tv-interactive-programming-guide-tips/
https://www.spectrum.net/support/tv/tv-interactive-programming-guide-tips/
https://www.spectrum.net/support/voice/caller-id-spoofing/
https://www.spectrum.net/support/voice/block-robo-callers/
https://www.spectrum.net/support/voice/dropped-calls/
https://www.spectrum.net/support/voice/cannot-make-or-receive-calls/
https://www.spectrum.net/support/voice/spectrum-voice-phone-features/
https://www.spectrum.net/support/video/setting-spectrum-tv/
https://www.spectrum.net/support/video/spectrum-tv-app-2/
https://www.spectrum.net/support/video/spectrum-guide-my-library/
https://www.spectrum.net/support/video/spectrum-guide-navigation-0/
https://www.spectrum.net/support/video/welcome-spectrum-guide/
https://www.spectrum.net/support/video/tv-everywhere-0/
https://www.spectrum.net/support/video/programming-your-remote-0/
https://www.spectrum.net/support/video/programming-your-spectrum-remote/
https://www.spectrum.net/support/video/spectrum-guide-demand/
https://www.spectrum.net/support/video/spectrum-guide-parental-controls/


Impacts to Recordings 

If you're recording and watching a program you'll see the caller information unless you 
turn off CIDTV, however if you're recording to watch a program later, your program will 
not record any Caller ID on TV information. You'll be able to see the call in the call logs. 

Top   

Troubleshooting 
Calls not displaying 

1. CIDTV may be turned off. Check the settings to verify Notification is turned set to 
"On." 

2. If your guide features the Snooze feature, it may be active. Check to verify if the 
Snooze feature is set to "On." Change the setting to "Off" to re-activate CIDTV. 
Note: This feature isn't available on all guides. 

3. Refresh your receiver   to reset the functionality. Note: If you refresh your receiver, 
it may take up to 24 hours for your Caller ID on TV feature to reactivate. 

4. Verify you subscribe to a Spectrum Voice phone package that includes Caller ID 
and the receiver can support CIDTV. 

You may have a mixture of receivers in your home where some can support 
CIDTV and others cannot, refer to the requirements at the beginning of this 
article to determine if your equipment supports CIDTV. 

5. If you've just installed Spectrum Voice service, you won't receive CIDTV alerts for 
up to 48 hours after activation of service. 

6. If you're receiving Caller ID on TV on at least one of your receivers, and only one is 
responding to the above trouble shooting steps, you'll need to contact us   . 

Non-Qualifying Customers 
If you don't meet the qualifications for CIDTV but you are interested in registering for 
CIDTV,  contact  us   . 

Top   

If you're a customer with a disability, please contact us  if you need assistance. 

Manage Account Get Support Watch TV 
 Find a Spectrum Store 

Account Summary Support Home Live TV 

Billing TV Guide  Get Weather Outage Info 

TV Internet My Library 

Internet Voice On Demand 
 Contact Us 

Voice Account Support DVR 

Settings 

© 2017 Charter Communications 

Your Privacy Rights California Privacy Rights Policies Go To Assist 

https://www.spectrum.net/support/tv/update-refresh-digital-receiver/
https://www.spectrum.net/support/general/contact-us/
https://www.spectrum.net/support/general/contact-us/
https://www.spectrum.net/page/accessibility/
https://www.spectrum.net/
https://www.spectrum.net/login/?targetUrl=%2Fbilling-and-transactions%2F
https://www.spectrum.net/login/?targetUrl=%2Fmy-tv-services%2F
https://www.spectrum.net/login/?targetUrl=%2Fmy-internet-services%2F
https://www.spectrum.net/login/?targetUrl=%2Fmy-voice-services%2F
https://www.spectrum.net/login/?targetUrl=%2Fuser-preferences%2F
https://www.spectrum.net/support/
https://www.spectrum.net/support/category/tv/
https://www.spectrum.net/support/category/internet/
https://www.spectrum.net/support/category/voice/
https://www.spectrum.net/support/category/my-account/
https://watch.spectrum.net/livetv?sessionOverride=true
https://watch.spectrum.net/guide?sessionOverride=true
https://watch.spectrum.net/watchlater?sessionOverride=true
https://watch.spectrum.net/ondemand/featured?sessionOverride=true
https://watch.spectrum.net/rdvr/my-recordings?sessionOverride=true
https://www.spectrum.net/support/locations/
https://www.spectrum.net/support/general/charter-storm-center/
https://www.spectrum.net/contact-us/
http://twitter.com/getspectrum
http://www.facebook.com/spectrum
http://www.youtube.com/c/getspectrum
https://www.spectrum.net/
https://www.charter.com/browse/content/your-privacy-rights
https://www.charter.com/policies/ca-privacy-rights
https://www.charter.com/policies/terms-of-service
http://www.helpmespectrum.com/
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Shop My Verizon  Support  Watch Fios I am looking for 

Wireless  Residential Business Contact Us Enter Your Location Español Sign In/Register 

Existing user? 
Sign in Sign in to manage & troubleshoot your services. 

Caller ID for Fios TV 
To view details of your outgoing, incoming, and missed phone calls, your Fios services and Set-top Box must meet the requirements for Caller ID. 

The following requirements must be met, you must: 
subscribe to Fios Digital Voice, Fios TV, and Fios Internet, and Caller ID 
have a Fios TV compatible Set-top Box 

Note: All Verizon-supplied routers and ONTs are compatible with Caller ID for Fios TV. Caller ID is not compatible with the Motorola 2500 STB or DCT 700 Digital Adapter. Sign into My Verizon 
to shop and upgrade your STB. 

Manage calling features 

Need more support? 

Set up caller ID 

To set up Caller ID on your Fios TV, follow these basic steps using your Fios remote control, press: 
Menu > Settings > Notifications > Caller ID > Check Availability, 

A message will display to indicate that Caller ID is either available or unavailable: 
If Caller ID is Available, press OK when prompted, select Yes to enable Caller ID, press OK 
If Caller ID is Unavailable, you currently do not meet the equipment or service requirements, press OK 

Note: Once Caller ID is activated, it may take 24–48 hours to see alerts. You must activate Caller ID on each Set-top Box where you want the service. 

Select alert options 

View call logs (Call Back/Block/Delete) 

View voice mail (Play Messages/Call Back/Block/Delete) 

Verizon forums Order status Repair status Contact Us 

Shop 

Fios Internet 

Fios TV 

Build My Bundle 

Accessories 

Moving 

Fios Availability 

Special Deals 

My Verizon 

Pay Bill 

Add or Change Plan 

My Rewards+ 

Apps 

Support 

TV 

Internet 

Phone 

Account Billing 

Order Status 

Repair Status 

Community Forums 

Watch Fios 

Watch TV Shows 

Watch Movies 

Check TV Listings 

Program My DVR 

Rent or Buy Movies 

View Pay Per View 

Tools 

Remote Assistance 

Report a Security Vulnerability 

Announcements 

Accessibility 

Consumer Education 

Speed Test 

Support TV Programming & Features TV Caller ID 

https://www.verizon.com/about/fios-accessibility-services
http://www.verizonwireless.com/?intcmp=VZ-GHOME-D-WIRELESS
https://www.verizon.com/?lid=//global//residential
http://www.verizon.com/home/verizonglobalhome/ghp_business.aspx
javascript:void(0);
http://espanol.verizon.com/
javascript:void(0);
https://www.verizon.com/support/residential/contact-us/homepage.htm
https://www.verizon.com/?lid=//global//residential
javascript:void(0);
https://www.verizon.com/?lid=//global//residential
https://www.verizon.com/home/fios-fastest-internet/
https://www.verizon.com/home/fiostv/
https://www.verizon.com/home/phone/fiosdigitalvoice/
https://www.verizon.com/home/bundles/fios/
https://www.verizon.com/home/fios/
https://www.verizon.com/home/shop/moving.htm
https://www.verizon.com/home/accessories/
https://www.verizon.com/home/myverizon/
https://www.verizon.com/home/myverizon/
https://www.verizon.com/foryourhome/ordering/myverizonnew/registrationbridge.aspx?FlowRoute=ACCOUNTREVIEW&FLOWROUTEVAL=MYVZ_HDR_SVC_ADDCHG&Source=MYVER
https://www.verizon.com/foryourhome/myaccount/pr/internet/details
https://www.verizon.com/foryourhome/myaccount/pr/tv/details
https://www.verizon.com/foryourhome/myaccount/pr/phone/details
https://www.verizon.com/foryourhome/billview/billing/mybill
https://www.verizon.com/foryourhome/equickpay/myvzhome/express?src=c
https://www.verizon.com/foryourhome/equickpay/code/payfinalbill.aspx
https://www.verizon.com/foryourhome/myaccount/ngen/pr/offers/home.aspx
https://www.verizon.com/foryourhome/myaccount/ngen/pr/rwrds/home.aspx
https://www.verizon.com/foryourhome/myaccount/pr/user/profile/tab/accset
https://www.verizon.com/support/residential/home
https://www.verizon.com/support/residential/home
https://www.verizon.com/support/residential/home
https://www.verizon.com/support/residential/tv/tv.htm
https://www.verizon.com/Support/Residential/internet.htm
https://www.verizon.com/Support/Residential/phone.htm
https://www.verizon.com/support/residential/billingcenter/homepage.htm
https://www.verizon.com/home/myverizon/
https://www.verizon.com/ForYourHome/VZRepair/vziha/CheckStatus.aspx
https://forums.verizon.com
https://www.verizon.com/support/residential/contact-us/index.htm
http://tv.verizon.com/
http://tv.verizon.com/
http://tv.verizon.com/livetv
http://tv.verizon.com/series
http://tv.verizon.com/movies
http://tv.verizon.com/networks
https://www.verizon.com/OnDemand/Payperview/Home
https://www.verizon.com/fiostv/myservices/Members/ftvc5/tvlistings.aspx
https://www.verizon.com/support/residential/home.htm
https://www.verizon.com/support/residential/tv/tv.htm
https://www.verizon.com/supportresidential/tv/programs-features/overview
https://myverizonid.verizon.com/amserver/UI/Login
https://forums.verizon.com
https://www.verizon.com/home/myverizon/
https://www.verizon.com/ForYourHome/VZRepair/vziha/CheckStatus.aspx
https://www.verizon.com/support/residential/contact-us/homepage.htm
https://www.verizon.com/home/fios-fastest-internet/
https://www.verizon.com/home/fiostv/
https://www.verizon.com/foryourhome/ordering/checkavailabilitylq.aspx
https://www.verizon.com/home/accessories/
https://www.verizon.com/home/shop/moving.htm
https://www.verizon.com/home/fiosavailability/
https://www.verizon.com/home/bundles/fios/
https://www.verizon.com/foryourhome/equickpay/myvzhome/express?src=c
https://www.verizon.com/foryourhome/ordering/myverizonnew/registrationbridge.aspx?FlowRoute=ACCOUNTREVIEW&Source=MYVER
https://www.verizon.com/foryourhome/myaccount/ngen/pr/rwrds/home.aspx
https://www.verizon.com/fiostv/myapps/unprotected/apps.aspx
https://www.verizon.com/Support/Residential/tv.htm
https://www.verizon.com/Support/Residential/internet.htm
https://www.verizon.com/Support/Residential/phone.htm
https://www.verizon.com/support/residential/billingcenter/homepage.htm
https://www.verizon.com/home/myverizon/
https://www.verizon.com/ForYourHome/VZRepair/vziha/CheckStatus.aspx
http://forums.verizon.com
http://tv.verizon.com/series
http://tv.verizon.com/movies
https://www.verizon.com/fiostv/myservices/Members/ftvc5/tvlistings.aspx
https://www.verizon.com/fiostv/myservices/members/ftvc5/schedules.aspx
https://www.verizon.com/OnDemand/Movies/All
https://www.verizon.com/OnDemand/Payperview/Home
https://www.verizon.com/Support/Residential/Generic/General/Show-me.htm
http://www.verizonwireless.com/landingpages/report-security-vulnerability/
http://www.verizon.com/announcements
https://www.verizon.com/about/fios-accessibility-services/
https://www.verizon.com/info/
https://www.verizon.com/speedtest/
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Xbox Live service is active. See details > 

Share Tw eet 

Office Windows Surface Xbox Deals Support More   Sign in 

Consoles Games Community Accessories Xbox on Windows Xbox Support My Xbox  

Share this page 

Record game clips with Game DVR on 
Windows 10 
Record game clips and screenshots of the games you love playing—on Xbox Live, Steam, or other services— 
and share with all your social networks. 

To start taking screenshots and making game clips, press the Windows logo key+G on your Windows 10 PC. 

Find the game clips and screenshots you made with Game DVR at Xbox app > Game DVR > On this PC. By 
default, the captures are saved to your Videos folder, in a folder called Captures. Each video and screenshot 
is identified with the game’s title and metadata that shows when the image was captured. 

On this page 

Topics 

Using Game DVR to create a game clip on Windows 10 
Keyboard shortcuts 

Using Game DVR to create a game clip on Windows 10 
While you’re playing a game, press the Windows logo key+G to open the Game bar. If a program has 
already been identified as a game, the Game bar will appear, as shown below: 

1. The Xbox button launches the Xbox App, which alternates with your gamerpic. 
2. Press the camera icon to take a screenshot. 
3. The Record that button turns the most recent few moments of gameplay into a game clip when 

background recording is turned on. To turn it on, go to Game bar > Settings > Record game in the 
background. 

4. The Record button starts and stops a recording. While you’re recording, a timer shows the length of 
the clip. 

5. The Settings button opens a pop-up window that allows you to control Game DVR settings. Learn 
more at  Adjust Game DVR settings on Windows 10. 

6. The Move button lets you change where the Game bar appears on the screen. 

The first time you use the Game bar with a particular game, you’ll be asked if you want to open the Game 
bar. Select the checkbox to confirm that program is a game. 

Some games may block your ability to record. If so, you’ll see the notification, “This app can’t be recorded.” 

Notes 

Game bar won’t appear for some PC games in full-screen mode. To start and stop recordings without 
using the Game bar, use the keyboard shortcut Windows logo key+Alt+R to start and stop recording. 
The screen will flash to indicate the start and end of recording. If background recording is turned on, 
Windows logo key+Alt+G will record the last few moments of gameplay. 
If the shortcuts don’t work for a full-screen game, press the Windows logo key+G. The screen will flash 
twice to confirm that the game is recognized. Then, open the game in full screen again. 

Keyboard shortcuts 
Keyboard shortcuts for Game DVR include: 

Windows logo key+G: Open the Game bar 

Xbox Support 
Xbox One 
Xbox 360 
Xbox on Windows 10 

Getting started 
Accessories 
Family safety and security 
Social 
Microsoft Store 
System requirements 

Games 
Billing 
My account 

https://www.microsoft.com
https://products.office.com/en-us/home
https://www.microsoft.com/en-us/windows/
https://www.microsoft.com/en-us/surface
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https://www.microsoft.com/en-us/store/b/sale?icid=gm_nav_L0_salepage
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Windows logo key+Alt+G: Record the last few moments of gameplay (You can change the amount 
of time recorded in Game bar > Settings.) 
Windows logo key+Alt+R: Start/stop recording 
Windows logo key+Alt+Print Screen: Take a screenshot of your game 
Windows logo key+Alt+T: Show/hide the recording timer 
Windows logo key+Alt+M: Start/stop microphone recording 

To set up and use customized keyboard shortcuts, press Windows logo key+G, select Settings > Shortcuts, 
and adjust the settings there. 

Related Issues 

Edit and share game clips with Game DVR in the Xbox App on Windows 10 
Troubleshoot Game DVR on Windows 10 
Troubleshoot gameplay issues on Windows 10 
Where to download games for Windows 10 

Back to top 

Support Resources 

Error & Status Repair and service Manuals and Post on the Chat with a 
Code Search center warranty info Community volunteer from 

Support Forums the community 

Contact Us 

Share this page 
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Broadcast your game with Mixer on 
Windows 10 
Mixer broadcasting makes it easy to stream your gameplay and let viewers watch and interact with you in 
real time. Use the Game bar to broadcast to  mixer.com  on your Windows 10 PC. 

You can broadcast just your game or your desktop—it's your choice. Remember that some games must be 
broadcasted in desktop mode, so if you're having trouble broadcasting your game, try that. 

To start broadcasting: 

1. Launch a game. 
2. Press Windows logo key + G on your Windows 10 PC to open the Game bar. 
3. Press the Broadcast button to choose how you want your broadcast to look. 
4. Press Start broadcasting to broadcast your game. 

If you notice your game has the wrong name in your broadcast: 

1. Press Start broadcasting to start the broadcast. 
2. Go to  mixer.com  to edit the name of your broadcast title. 

The Game bar won't appear for some PC games in full-screen mode. To start and stop broadcasting without 
using the Game bar, press Windows logo key + Alt + B to start or stop recording and Windows logo key 
+ Alt + W to show the camera during your broadcast. 

To set more detailed settings for your future broadcasts, select the Start button, then Settings > Gaming > 
Broadcasting. 

Related Issues 

Create a Mixer account 
Link a Mixer account to your Microsoft account 
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How to use QuickTime Player 
Use QuickTime Player (version 10) to play, record, edit, and share audio and video 
files on your Mac. 

Play Record Edit 

Play 
Use the playback controls to play, pause, rewind, fast-forward, adjust volume, and take 
other actions. The controls appear when you move your pointer over the QuickTime Player 
window, and they hide when you move your pointer away. 

To move quickly forward or backward through the timeline, swipe with two fingers on your 
trackpad, scroll with your mouse, or drag the handle in the timeline. You can also 
repeatedly click fast-forward or rewind to increase playback speed in increments. 

To view a video in full screen, click the  full-screen button  or choose View > Enter Full 
Screen. Beginning with OS X El Capitan, you can also use split-screen view  and  stream 
videos to your Apple TV  from QuickTime Player. 

Record 
QuickTime Player can  record a movie  from your camera, or record the screen of your 
iPhone, iPad, or iPod touch. It can also  record audio  from a microphone or  record the 
screen  of your Mac. 

https://www.apple.com/
https://www.apple.com/mac/
https://www.apple.com/ipad/
https://www.apple.com/iphone/
https://www.apple.com/watch/
https://www.apple.com/tv/
https://www.apple.com/music/
https://support.apple.com/
https://support.apple.com/kb/index?page=search&locale=en_US
https://www.apple.com/us/shop/goto/bag
https://support.apple.com/kb/PH18744
https://support.apple.com/kb/HT204948
https://support.apple.com/kb/HT201343


Record a movie 
Movie recording works with your built-in camera and many external cameras. If you're 
using OS X Yosemite or later, you can also record the screen of any iOS device (iPhone, 
iPad, iPod touch) with a Lightning port and iOS 8 or later. 

1. Choose File > New Movie Recording. 
2. To change the recording settings, click the arrow next to the Record button. Then 

choose your camera or iOS device, microphone, and recording quality. 

3. To monitor audio while it's being recorded, use the volume slider. 
4. Click the Record button to start recording. Click it again to stop recording. 

Record audio only 
Audio recording works with your built-in microphone, external microphone, or 
other Core Audio-compliant audio device. 

1. Choose File > New Audio Recording. 
2. To change the recording settings, click the arrow next to the Record button. Then 

choose your microphone and recording quality. 
3. To monitor audio while it's being recorded, use the volume slider. 
4. Click the Record button to start recording. Click it again to stop recording. 

Record your screen 
Screen recording creates a movie of all or part of your Mac screen. To record the screen 
of your iPhone, iPad, or iPod touch, use the movie-recording function  instead. 

1. Choose File > New Screen Recording. 
2. To change the recording settings, click the arrow next to the Record button. If you don't 

want to record a voiceover or other audio, choose None as your microphone. If you 
want to show a black circle for every onscreen click, choose Show Mouse Clicks in 
Recording. 

3. To monitor audio while it's being recorded, use the volume slider. 
4. To start recording, click the Record button , then click anywhere on the screen to 

begin recording the entire screen. Or drag to select an area to record, then click the 
Start Recording button within that area. 

5. To stop recording, click the Stop button in the menu bar, or press Command-
Control-Esc (Escape). 

Edit 
QuickTime Player offers several options for editing your movie, including trim, 
split  ,  cut/copy/paste/delete  , and  flip/rotate  . 

Trim 



Use the trim function to remove unwanted parts of your movie. 

1. Choose Edit > Trim. The yellow trimming bar appears, with handles on each end. 

2. Drag the handles to select the part to keep. You can also take these actions: 

Click the Play button to play back the part selected. 
Move quickly through the part selected by swiping with two fingers on your trackpad, 
scrolling with your mouse, or dragging within the trimming bar. 
Choose View > Show Audio Track to identify quiet sections of the movie. 

3. Click Trim. All video and audio outside the trimming bar is removed. To undo the trim, 
choose Edit > Undo Trim. 

Split 
Use the split function to split your movie into multiple sections that can be manipulated 
further. 

1. Go to the point in the timeline  where you want to make the split, then choose Edit > 
Split Clip. 

2. From here you can take several actions: 

Drag a clip before or after another clip. 
Move through a clip by swiping with two fingers on your trackpad or scrolling with 
your mouse. At any point in the timeline, you can choose Edit > Split Clip to split the 
selected clip. 
Choose View > Trim to  trim  the selected clip. 
Choose View > Show Audio Track to identify quiet sections of the clip. 
Select a clip and choose other editing commands from the Edit menu, such as Cut, 
Copy, Paste, and Delete. 
Click the Play button to play back all clips. 

3. Click Done. To see your clips again, choose View > Show Clips. To undo your splits, 
choose Edit > Undo Split Clip. 

Cut, Copy, Paste, Delete 
Use the Cut, Copy, Paste, and Delete commands from the Edit menu when you're editing 
split clips  . If you're pasting a clip into another movie, you don't have to be editing clips in 
that movie: just go to any point in the timeline of the other movie, then paste the clip. 

To quickly join movies together end to end, open the first movie, choose Edit > Add Clip to 
End, then select the other movie from the file dialog. 

Flip, rotate 
Use the flip and rotate commands from the Edit menu when you're viewing a movie 
or  editing split clips  . These commands flip or rotate the entire movie or clip. 

Share 
After saving your movie, you can share it by Mail, Messages, AirDrop, YouTube, and other 
methods: 



Copyright © 2018 Apple Inc. All rights reserved. Privacy Policy Terms of Use Sales and Refunds Site Map Contact Apple United States (English) 

Open the file in QuickTime Player, then choose File > Share. 
Or open file in QuickTime Player, then click Share  in the 
playback controls. 
Or Control-click the file in the Finder, then choose Share 
from the shortcut menu. 

Learn more 
For more information, open QuickTime Player and choose Help > QuickTime Player Help. 

If QuickTime Player can’t open an audio or video file 
Use the captioning features in QuickTime Player 
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Support How to use QuickTime Player 

More ways to shop: Visit an  Apple Store  , call 1-800-MY-APPLE , or  find a reseller  . 
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How to record the screen on your iPhone, 
iPad, or iPod touch 
In iOS 11, you can create a screen recording and capture sound on your iPhone, 
iPad, or iPod touch. 

Record your screen 
1. Add Screen Recording to Control 

Center. Go to Settings > Control 
Center > Customize Controls, then 
tap next to Screen Recording. 

2. Open Control Center  . 
3. Tap , then wait for the three-second 

countdown. To capture sound while 
you record, press deeply on and 
tap Microphone Audio. 

4. To stop recording,  open Control 
Center  and tap . Or tap the red 
status bar at the top of your screen 
and tap Stop. 

You can find your screen recording in the 
Photos app. 

Learn more 
Learn how to  take a screenshot on your 
iPhone, iPad, or iPod touch  . 
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Capturing game clips and screenshots 
Capturing game clips and screenshots 

To capture what just happened: 

1. Start your game and play as usual. 
2. When something cool happens and you want to record it, press to open the guide, then press 

to grab the last 30 seconds. 

To capture a screenshot instead, press instead of . 

Note The screenshot is taken when you press . Pressing saves it. 

To capture what just happened using voice, say ”Hey Cortana, record that!”To capture what just happened, 
say ”Xbox, record that!” 

To capture what's going to happen next: 

1. Start your game. Press to open the guide. 
2. Press , then select Start recording. Depending on your game clip resolution and available storage 

space, clips can last up to 10 minutes (capturing to internal storage) or 1 hour (capturing to external 
storage). 

3. To end the clip, press You'll get a message when your clip is saved. 

To see your captures, select Manage captures. Select any capture to see what you can do with it. 

To set your clip resolution and capture location, press the Xbox button to open the guide, then go to 
Settings > Preferences > Broadcast & capture. 

Note Saving and sharing screenshots requires Xbox Live Gold. If you don’t have it, you can take screenshots 
on someone else’s home Xbox as long as someone with Xbox Live Gold is signed in. For more, see  Using 
Xbox Live Gold sharing features on Xbox One. 
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Help PS4 PS VR  Games PS Plus News PS Store 

We use cookies to personalise your experience and ads on this site & others. For more info or to change 
settings, click here.   

SIGN IN 

01  Go to [Settings] > [PlayStation Network/Account Management] > [Link with Other Services]. 

Updated 03 October 2017 

How to broadcast on YouTube using your PlayStation 4 
System Features : PlayStation Apps & Features 

Please follow these steps if you want to broadcast your gameplay from your PlayStation 4 system, using your linked YouTube 
account. 

■ How to link your YouTube account with your SEN account 

■ How to broadcast using YouTube on your PlayStation 4 system 

■ Broadcasting on PS4 Pro 

How to link your YouTube account with your SEN account 

02  Select [YouTube] and sign in using your YouTube account details. 

03  Once you sign in you will receive a confirmation on screen that both accounts are now linked. 

https://www.playstation.com/en-gb/legal/cookies/
javascript:void(0);
https://www.sony.net
https://www.playstation.com/en-gb/
https://www.playstation.com/en-gb/explore/ps4/
https://www.playstation.com/en-gb/explore/playstation-vr/
https://www.playstation.com/en-gb/explore/ps4/games/
https://www.playstation.com/en-gb/explore/playstation-plus/
https://blog.eu.playstation.com/
https://www.playstation.com/en-gb/buy/playstation-store/
https://www.playstation.com/en-gb/get-help/
https://psmedia.playstation.com/is/image/psmedia/link-services-youtube-ui-01-ps4-en-29sep15?$MediaCarousel_Original$


How to broadcast using YouTube on your PlayStation 4 system 

01  While playing the game of your choice use the SHARE button on your DualShock 4 controller to open the “Broadcast 
Gameplay” menu. From there you can select YouTube as service to broadcast on. 

Note: If it is your first broadcast using the YouTube service you will have to agree to the YouTube terms of service to enable 
streaming. Please follow the instructions on the screen. 

02  Before starting the broadcast you will be able to personalise some broadcast details such as Microphone/PlayStation Camera 
inclusion, and the display of Spectators Comments. In addition to this, by pressing the “OPTIONS” button, and Advanced 
Broadcast menu will appear on screen. 

Broadcasting on PS4 Pro 

You can’t Broadcast in 4K from your PS4 Pro system, but you can Broadcast in up to 1080p (60fps) depending on broadcast 
service used and bandwidth. HDR is not supported. 

■ YouTube 

Up to 1080p (60fps) is available - quality will depend on YouTube network traffic. 

■ Twitch 

1080p (60fps) is available. 

■ DailyMotion 

1080p (60fps) is available for selected verified DailyMotion account holders. 

https://psmedia.playstation.com/is/image/psmedia/broadcast-youtube-menu-ui-01-ps4-en-29sep15?$MediaCarousel_Original$
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PlayStation®4 User's Guide 

Basics Uploading a video clip 

Settings 
You can save gameplay as a video clip. Video clips can then be shared with other players by uploading them to 
online services. 

Games 

Share Saving a video clip About sharing 

Friends Sharing content 
Video of the most recent 15 minutes of gameplay is continuously and automatically recorded. You can save 
gameplay as a video clip, in either of the following ways. 

Communities Uploading a screenshot Press the SHARE button, and then press the button. 
Press the SHARE button, and then select [Save Video Clip]. 

Events Uploading a video clip 

Messages Broadcasting your gameplay 

Party Sharing your gameplay 

Video/TV Viewing content from other players 

Music 

Some games contain scenes that cannot be recorded. The maximum 15 minutes of gameplay that 
are saved as a video clip do not include scenes in which video cannot be recorded. An icon appears 
in the upper left corner of the screen at the start and end of these scenes. 
When you know the scene you want to save, press the SHARE button twice at the start of the scene, 
and then press the SHARE button again twice at the end of the scene. If you do not press the 
SHARE button at the end of the scene, recording will continue until you reach the maximum length 
allowed by your video clip settings, and then the video clip will be saved. 
To change settings for video clips and uploads, select (Settings) > [Sharing and Broadcasts]. 

Viewing video clips that you saved 

Select (Capture Gallery) from the content area. 

Press the OPTIONS button to sort saved video clips by name or date, and delete video clips. You can also 
copy saved video clips to a USB storage device. 

FAT and exFAT formatted USB storage devices are supported. 
Be sure to fully insert the USB storage device into the USB port. Some devices are not compatible 
due to shape or design. 
With HDR enabled, the colors in the saved video clips might be different from the colors in the 
gameplay video. 

Uploading a video clip 

1. Press the SHARE button, and then select [Video Clip] to save the video clip. 
2. Select an online service. 
3. Select a video clip. 
4. Edit the video clip 

Select [Trim] to edit a video clip's start point and end point. You can also add comments or limit who can 
see what you share. 

5. Select [Share]. 

The first time you connect to an online service, you must enter your account information for that 
service. If you do not have an account, create one by visiting the online service's website. 
Only one video clip can be uploaded at a time. 
Methods for deleting uploaded video clips vary by online service. 

Related topics 

Activities 
Link with Other Services 
Audio Devices 

Important consumer notices  |  Language selection  |  Manual index  |  Intellectual property notices 

Support  |  About this site 

This guide is for use with system software version 5.00 or later. 
© 2017 Sony Interactive Entertainment Inc. 

http://manuals.playstation.net/document/en/ps4/index.html
http://manuals.playstation.net/document/en/ps4/share/about_share.html
http://manuals.playstation.net/document/en/ps4/share/screenshot.html
http://manuals.playstation.net/document/en/ps4/share/broadcast.html
http://manuals.playstation.net/document/en/ps4/share/gameplay.html
http://manuals.playstation.net/document/en/ps4/basic/activity.html
http://manuals.playstation.net/document/en/ps4/settings/services.html
http://manuals.playstation.net/document/en/ps4/settings/audiodevice.html
http://manuals.playstation.net/document/en/ps4/share/screenshot.html
http://manuals.playstation.net/document/en/ps4/share/broadcast.html
http://manuals.playstation.net/document/en/ps4/others/important.html
http://manuals.playstation.net/document/
http://manuals.playstation.net/document/en/ps4/others/manualindex.html
http://manuals.playstation.net/document/en/ps4/others/notices.html
http://manuals.playstation.net/document/en/terms.html
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Let the fun begin 
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TiVo Roamio DVR 

Beyond the basics 
of your TiVo Roamio 

TiVo Stream 

TiVo Mini 
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Let the fun begin. 

TiVo Central, your entertainment headquarters. 

The starting point for the TiVo Roamio ex perienc e is TiVo C entral . Get there by pressing the ® ® 

metallic TiVo button on the top of y our remote. From here, y ou c an go to My Shows to see 
ev ery thing y our DVR has rec orded; searc h and browse for something else to watc h; see what’s 
sc heduled to rec ord on y our To Do List; or manage y our fav orite OnePassTM rec ordings. 

https://www.tivo.com/
https://www.tivo.com/shop/cart
https://www.tivo.com/
https://www.tivo.com/quick-links/welcome-center-roamio
https://www.tivo.com/quick-links/welcome-center-roamio/get-set-up
https://www.tivo.com/quick-links/welcome-center-roamio/get-more-from-roamio
https://www.tivo.com/quick-links/welcome-center-roamio/beyond-the-basics
https://www.tivo.com/quick-links/welcome-center-stream
https://www.tivo.com/quick-links/welcome-center-mini
http://www.youtube.com/tivo
http://www.facebook.com/tivo
http://twitter.com/tivo
http://blog.tivo.com


For v oic e remote c ustomers:If y ou hav e rec ently purc hased a new TiVo v oic e remote, make 
sure y ou upgrade now if y ou hav e not already to the new TiVo ex perienc e to enable v oic e. 
Upgrade now 

Complete control at your fingertips. 

W ith y our TiVo remote c ontrol in hand, y ou c an searc h, disc ov er and ex plore endless 
entertainment—all in just a few c lic ks. Get a feel for our unique remote c apabilities, like 
SkipModeTM  and Quic  kModeTM,  to help y ou master y our entertainment ex perienc e. 

SkipMode 

TiVo Roamio skips entire c ommerc ial breaks at the 
press of a button (the D button, to be ex ac t) on 
c ertain rec orded shows. A few minutes after a show 
has aired, y ou’ll see a Skip ic on nex t to the show title 
in y our My Shows folder when y ou’re able to skip 
c ommerc ials. W hen watc hing a Skip-eligible show, 
just press the D button during the c ommerc ial 
break and y ou’ll be bac k to enjoy ing y our show 
instantly . 

W hat c hannels and times are eligible for  SkipMode? See  c omplete list. 

https://www.tivo.com/upgrade-experience
https://www.tivo.com/support/how-to/how-to-use-SkipMode
https://www.tivo.com/support/how-to/how-to-fast-forward-with-QuickMode
https://fast.wistia.net/embed/iframe/mqdlrjgv93?popover=true
https://www.tivo.com/assets/images_assets/skip-mode-here-new.png


QuickMode 

Quic kMode lets y ou watc h rec orded shows and 
sports 30% faster than normal speed—without the 
sound getting squirrely on y ou. It’s great for getting 
through the dull stuff without missing any of the 
ac tion. W hen y ou’re watc hing a rec orded show, 
turn Quic kMode on by pressing “Play ,” then pressing 
“Selec t” when the Tric kPlay TM bar appears. 

Additional resources 
How to use SkipMode 
How to use QuickMode 
Printable TiVo remote map (PDF) 

https://fast.wistia.net/embed/iframe/kvjcscsm0q?popover=true
https://www.tivo.com/support/how-to/how-to-use-SkipMode
https://www.tivo.com/support/how-to/how-to-fast-forward-with-QuickMode
https://www.tivo.com/assets/pdfs/welcome_center/Argon_RemoteCallouts.pdf


Don’t miss it. Schedule it. 

Roamio makes it easy to rec ord all the shows y ou 
lov e so they ’re waiting for y ou to watc h. Simply set 
up a OnePass or a W ishList searc h. ® 

OnePass 
Take the stress out of remembering to rec ord eac h episode of y our fav orite 
TV series. Simply set up OnePass to gather ev ery episode of any season or all 
seasons of y our fav orite show from TV or streaming options suc h as Netflix , 
Amazon Prime, Hulu, HBO GO, on demand (if av ailable) and other streaming 
sourc es. Learn ev ery thing y ou need to know about  OnePasshere. 

WishList Search 
If y ou know what y ou like, but aren't sure when it's on, simply c reate a W ishList 
searc h. Searc h by ac tor, direc tor, key word or c ategory and ev ery time a show 
matc hing y our c riteria airs, it's rec orded. 

Schedule recordings and more with the TiVo app. 
Using the free TiVo app for mobile dev ic es, y ou c an 
sc hedule and manage shows when y ou’re away 
from home. W ith y our mobile y ou c an also watc h 
liv e and rec orded TV around the house or around 
the  world. Learn  more 

Schedule your recordings online. 
Forget to sc hedule a rec ording? Don't panic . Just v isit tiv o.c om 
from any where and searc h for shows, browse air times and 
c hannels, and sc hedule y our desired rec ording online. Just v isit 
TiVo OnlineTM  at online.tiv o.c om  from any where. 

https://fast.wistia.net/embed/iframe/qbojphmx8l?popover=true
https://www.tivo.com/onepass
https://www.tivo.com/discover/mobile-apps/
https://online.tivo.com


Additional resources 
How to quickly set up single recordings 
How to set up a OnePass 
How to create a WishList search 
How to schedule shows online 
How to schedule shows from the TiVo app 

Roamio finds all your favorite shows. 
Find great things to watc h from both TV and the web in one simple searc h. You will also like the 
more adv anc ed browse and suggestion features of Roamio. The Disc ov ery Bar, C ollec tions and 
the W hat To W atc h Now feature giv e y ou all ty pes of entertainment results to watc h in sec onds. 

Additional resources 
How to browse for shows 
How to use the Discovery Bar 
How to use TiVo Search 

https://www.tivo.com/support/how-to/how-quickly-set-single-recordings
https://www.tivo.com/support/how-to/how-to-use-one-pass
https://www.tivo.com/support/how-to/how-create-wishlist-search
https://www.tivo.com/support/how-to/how-schedule-shows-web
https://www.tivo.com/support/how-to/how-find-record-shows-your-mobile-phone-using-tivo-mobile
https://www.tivo.com/support/how-to/how-browse-shows
https://www.tivo.com/support/how-to/how-use-discovery-bar-and-video-window
https://www.tivo.com/support/how-to/how-search-shows


Setting up recordings is even easier with 
OnePass Quick Select. 

W ith TiVo’s OnePass Quic k Selec t, sc hedule all y our 
fav orite OnePass shows with a single c lic k. Quic k 
Selec t giv es y ou a quic k v iew of the most popular 
shows on TV and lets y ou c reate a OnePass rec ording 
for multiple shows on one sc reen. 
C hec k it out  at TiVo Online  under “Manage”. 

Transfer multiple recordings, OnePasses and Season Passes from 
your old DVR. 

Transfer OnePasses and Season Passes 
Go to the “Manage” sec tion  at online.tiv o.c om  to transfer y our OnePass/Season Passes. 
Simply selec t the OnePass/Season Passes y ou want to transfer from y our old DVR and drag 
them to the TiVo BOLT c olumn on y our c omputer sc reen. All y our OnePass/Season Passes 
will be av ailable on y our new box so y ou won't miss any of y our fav orite shows. This feature 
is av ailable on TiVo Series3/HD, TiVo Premiere, TiVo Roamio and TiVo BOLTTM. ® ® 

NO TE: TiVo Se rie s2 box e s ca n cre a t e ne w 
O ne Pa sse s e a sily using O ne Pa ss  Q uick 
Se le ct  (se e a bov e ). 

https://www.tivo.com/support/how-to/tivo-online
https://online.tivo.com
https://www.tivo.com/quick-links/welcome-center-tivo-bolt/lets-master-the-basics#quick-select


Transfer recordings from one TiVo box to another. 
Transfer rec ordings between y our TiVo box es by v isiting TiVo Online. Go  to online.tiv o.c om  and 
selec t "Manage". From there, y ou c an selec t single rec ordings, multiple rec ordings, or all 
rec ordings to transfer from one TiVo box to another. You'll see a c onfirmation sc reen when 
y our rec ordings are being transferred. This feature is av ailable on TiVoSeries3/HD, Primiere, ® 

Roamio and TiVo BOLT. Rec ordings c annot be transferred to TiVo Series3/HD box es. 

- Indica t e s t ha t t he shows 
ca n't be t ra nsf e rre d. 

- Indica t e s t ha t t he it e m is 
curre nt ly be ing re corde d 
a nd ca nnot be t ra nsf e rre d. 

NO TE: Whe n t ra nsf e rring re cordings be t we e n 
TiVo box e s, If y ou run out of st ora ge spa ce on 
t he re ce iv ing DVR, t he n t he olde st re corde d 
shows on t ha t DVR will be de le t e d t o ma ke 
room f or t he shows y ou're curre nt ly 
t ra nsf e rring. 

Additional resources 
How to transfer shows from a TiVo Series2 DVR 

Our Company 

Quick Links 

Sitemap 

Our Products 

Get Involved 

http://online.tivo.com/start
https://www.tivo.com/support/how-to/stream-and-transfer-recordings-between-tivo-boxes
https://www.tivo.com/sitemap


Email Signup 

Safety & Compliance 

Legal 

Privacy 

Cookies 

https://www.tivo.com/safety-compliance
https://www.tivo.com/legal
https://www.tivo.com/legal/privacy
https://www.tivo.com/legal/cookies
http://www.youtube.com/tivo
http://www.facebook.com/tivo
http://twitter.com/tivo
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Beyond the basics of your 
TiVo Roamio DVR. 

Take TiVo everywhere with TiVo Roamio. 

Take y our TiVo Roamio ex perience bey ond the liv ing room when y ou add TiVo Mini to additional 
TVs. W hen paired with a TiVo Mini, Roamio prov ides a whole-home solution y ou won’t find 
any where else. W ant to to take y our fav orite shows on the go? Use y our iOS or Android dev ice to 
watch liv e TV or recorded shows any where around the house, or download y our fav orite shows 
and take them on y our nex t flight. 

https://www.tivo.com/
https://www.tivo.com/shop/cart
https://www.tivo.com/
https://www.tivo.com/quick-links/welcome-center-roamio
https://www.tivo.com/quick-links/welcome-center-roamio/get-set-up
https://www.tivo.com/quick-links/welcome-center-roamio/let-the-fun-begin
https://www.tivo.com/quick-links/welcome-center-roamio/get-more-from-roamio
https://www.tivo.com/quick-links/welcome-center-stream
https://www.tivo.com/quick-links/welcome-center-mini
http://www.youtube.com/tivo
http://www.facebook.com/tivo
http://twitter.com/tivo
http://blog.tivo.com


Access your shows from another room. 

TiVo Mini 
TiVo® Mini lets y ou to share y our TiVo ex perience on 
another TV in y our house. W atch liv e TV, recorded 
shows and stream from the web in y our bedroom, th 
office or the kitchen. Add two, three, or more Minis 
and share the lov e in multiple rooms. 
Learn more 

Multi-Room Streaming. 
Multi-Room Streaming lets y ou 
watch shows instantly between two 
or more network-connected TiVo 
Premiere,TiVo Roamio or TiVo BOLT 
DVRs. You can pause in one room 
and finish watching in another, plus 
access premium content whenev er 
y ou want, wherev er y ou want. 

Please not e: Using a wireless adapt er f or 
Mult i-Room St reaming is not support ed. 
Use a wired Et hernet or TiVo Bridge 
connect ion. Verizon FiOS households are 
already MoC A -enabled, so no addit ional 
adapt ers are required. 

How to stream shows between TiVo DVRs 

https://www.tivo.com/shop/mini
https://www.tivo.com/support/how-to/stream-and-transfer-shows-between-tivo-boxes


Multi-Room Viewing. 
Transferring shows (downloading) 
between TiVo DVRs is av ailable on 
all Internet-connected TiVo DVRs. 

Please not e: Some shows cannot be 
t ransf erred due t o t he copy prot ect ion 
assigned t hem by t he program prov ider. 
These shows are usually marked wit h a 
red circle-slash icon. 

Additional resources 
How to connect your TiVo DVR to your network and the Internet 
Learn more aboutTiVo Bridge network adapters 
How to transfer single and multiple recordings between TiVo boxes 

Watch your shows on any screen. 

Watch on your mobile device. 
W ho say s y ou hav e to watch TV on TV? Roamio 
lets y ou stream liv e or recorded shows to y our 
iOS or Android dev ices any where. Or transfer all 
y our fav orites to y our iPad or iPhone and take 
them wherev er y our busy life takes y ou. W hether 
y ou're on the couch, in the backy ard or on an 
airplane, y our shows are alway s at y our fingertips. 
Learn more 

4-tuner Roamio users: To  watch shows on y our iOS or Android dev ice, or to download shows 
to y our iOS dev ice, y our 4-tuner Roamio requires a TiVo Stream (sold separately  ).Shop now 

6-tuner Roamio Pro/Plus users:You  can already watch shows on y our iOS or Android dev ices, 
or download shows to y our iOS dev ices. Nothing ex tra  required.Learn  more 

https://www.tivo.com/support/how-to/how-connect-your-tivo�-box-your-home-network
https://www.tivo.com/moca
https://www.tivo.com/quick-links/welcome-center-roamio/let-the-fun-begin#transfer-recordings
https://www.tivo.com/support/how-to
https://www.tivo.com/shop/outlet#dvrs
https://www.tivo.com/support/how-to


Cast to your TV from a mobile device. 
W ant to transfer a show y ou’re currently watching on a 
mobile dev ice to the big screen with a simple swipe? Cast it! 

Netflix & YouTube  apps: Cast  to y our TV directly from the 
Netflix & YouTube mobile apps. Just swipe the icon. 

AirPlay :  Apple TV owners, sy nc y our iOS dev ice and AirPlay 
dev ice to the same network, then start a show from the 
TiVo app. Once y ou enable the AirPlay feature in the iOS 
control center on y our mobile dev ice, y ou’re all set! 

Watch shows on other TVs with Fire TV. 
W ith the TiVo app on y our Amazon Fire TV or Fire TV 
Stick, y ou can watch y our recorded shows on any TV at 
home. Just select a DVR to play from, set up streaming 
to the app and control y our play back ex perience. 

View on your computer. 
W ith TiVo Online, watch recorded shows on y our 
laptop or desktop computer any where around the 
house. In the mood for something new? Find 
something to watch right away with the "W atch Now" 
feature. Search TV, on-demand and other av ailable 
online sources like ABC, TNT, TBS and many more. It’s 
all in one place with TiVo Online. 

6-tuner Roamio Pro/Plus and Stream  users: Access 
y our recorded shows through any web browser on 
y our computer around the house. 

A dditional resources 
How to use the TiVo mobile app 
How to watch shows with Amazon Fire TV 
How to use TiVo Online 

See how t o bring t he power of TiVo t o y our 
comput er’s browser wit h TiVo Online. 

https://fast.wistia.net/embed/iframe/whjjd1x16q?popover=true
https://fast.wistia.net/embed/iframe/whjjd1x16q?popover=true
https://www.tivo.com/discover/mobile-apps
https://support.tivo.com/SupportPortalArticleViewPage?artURL=/articles/Features_Use/TiVo-App-for-Amazon-Fire-TV-Use
https://www.tivo.com/support/how-to/tivo-online
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TiVo RoamioOTA 1TB ® 

DVR 
Freedom has more space than ever. 

0 

Buy Now 

A premium experience without the premium 
price. 
The TiVo Roamio OTA DVR was designed to help you find the best that free over-the-air TV can offer with 
an on-screen experience that rivals the most advanced digital cable systems for a fraction of the cost. 
Roamio works with any HD-capable TV antenna, and records over 150 hours of HDTV programming (that’s 
one terabyte of storage space!). 

The Roamio OTA also boasts TiVo’s unique fan-favorite features including SkipModeTM, OnePassTM, 
OneSearchTM  and more. Roamio integrates all your streaming content from Netflix, Amazon Prime, Hulu, 
YouTube, Pandora and many others. Best of all, there are no monthly fees with Roamio. Pay once and the 
rest is all free-TV gravy. Combine Roamio OTA with the VOX  Remote  (purchase here),  and use your voice to 
make finding something to watch even easier! 

https://www.tivo.com/
https://www.tivo.com/shop/cart
https://www.tivo.com/shop/bolt-detail#tech
https://www.tivo.com/shop/buy-roamio-ota-dvr
javascript:void(0)
https://business.tivo.com
http://online.tivo.com/start
https://www.tivo.com/tivo-mma/mma-activate/activateservice.do
javascript:void(0)
https://www.tivo.com/tivo-mma/login/show.do
https://www.tivo.com/
https://www.tivo.com/shop/detail/tivovoxremote


Find movies and shows with 
unified search. 
OneSearch scours multiple sources, including 
broadcast TV and streaming apps, so your search 
experience is always fast, simple and seamless. 
No more drilling down into each app and doing 
multiple hunt-and-seek searches.The Roamio 
OTA allows full OneSearch functionality, and 
when paired with a VOX remote, simply speak 
your search into the remote! Say “I want James 
Bond movies with Daniel Craig” or “Show me 
Batman by Christopher Nolan” and other similar 
commands to easily find shows and movies by 
title, actor or director. 

Organize every season and 
episode into a unified 



watchlist. 
OnePass tracks down every available season TM  

and episode — whether it's on television or a 
streaming app — and creates a customized 
watchlist for you. OnePass lets you catch up on TM  

early seasons from online sources, and then 
automatically records current and upcoming 
episodes and adds them to your list to let you 
view them in order. 

Advanced control features you can’t get with 
cable or satellite. 
Using an HD antenna shouldn’t require you to sacrifice features or variety. That’s why Roamio OTA is 
packed with the most advanced control features TiVo has to offer, like SkipModeTM, QuickModeTM  and 
OneSearchTM. Roamio OTA also delivers must-have conveniences like a two-week program guide, the 
ability to record up to four shows at once, and watch-and-control mobile capabilities. Get a premium 
experience at a fraction of the cost of competing cable or satellite boxes. 

Skip commercial breaks with 
the new SkipModeTM. 



No more waiting for commercial breaks to be over. W 
a single press of a button, you can continue watching 
your recorded show. SkipMode works with the main 
channels, including ABC, CBS, NBC, Fox, The CW and 
more. 

WATCH VIDEO 

Watch more, faster, with 
QuickModeTM  . 
QuickMode zips you through your recorded shows 30% 
faster than normal speed with pitch-corrected audio. 
You zoom along and nobody sounds like a caffeinated 
chipmunk. It's the ideal way to power through slow-
moving news shows, talk shows, political debates and 
more. QuickMode even works for live shows that are 
being captured in the live TV buffer. 

WATCH VIDEO 

Record up to four shows at one time. 
Roamio OTA’s 1 terabyte (TB) of recording capacity translates to 
approximately 150 hours of HDTV recording capacity. The 4 built-in 
tuners can be used to record up to 4 TV programs at the same time, or 
to view multiple TV programs on different TV’s in your household when 
paired with a TiVo Mini or TiVo Mini VOX. 

A remote control that never gets lost. 
Whether you’re across the room or behind a wall, TiVo’s unique radio 
frequency (RF) remote gives you control over your TiVo Roamio OTA, 

https://fast.wistia.net/embed/iframe/mqdlrjgv93
https://fast.wistia.net/embed/iframe/kvjcscsm0q


Streaming Apps 
Netflix, Hulu, Amazon 

Unified Search & Watchlist 

SkipMode & QuickMode 
Recorded TV 

RF voice remote compatible 

even if it's far away or tucked behind a cabinet door. And if your remote 
gets misplaced, the TiVo Roamio OTA helps you find it – just press the 
"Remote Finder" button on the Roamio OTA and your remote beeps to 
alert you to its location. 

How TiVo Roamio OTA DVR measures up to 
other boxes. 

Channel Master 
TiVo Roamio OTA DVR+ Tablo 4 

Storage 1 TB 1 TB External HD 
Hard drive 

TV and streaming apps 

Tuners 4 2 4 

The Tru Multi RoomTM  Experience 
You don’t spend all of your time in one room, so why should 
your TV entertainment be trapped? TiVo Roamio OTA let 
you expand your viewing experience beyond the living 



room – seamlessly – no matter what screen you happen 
have in front of you. Fire up your mobile device, flip open 
your laptop or create a whole-home HDTV solution with a 
TiVo Mini in every room. And, wherever there’s a Mini VOX 
with the included VOX Remote, simplicity is always within 
earshot – Say it - Find it - Watch it. 

Control TiVo Roamio OTA with the TiVo mobile 
app for IOS and Androiddevices. TM  

Same unified search Watch in app or on Schedule a 
as TiVo Roamio OTA. your TV. recording or create a 

watchlist. 

http://itunes.apple.com/us/app/tivo/id401673976?mt=8&ls=1
https://play.google.com/store/apps/details?id=com.tivophone.android&hl=en


Tech Specs 

Inputs/Outputs 

1. Coax (HD antenna) 
2. Digital optical audio 
3. Composite Video / Analog audio 

4. HDMI® 1.1 / (1080p 24/60) 
5. Ethernet port: 10/100 Mbps 
6. USB 2.0 ports 
7. External storage port (eSATA) 

8. Dimensions Power: 12V and Weight 



1 

Specifications Recording capacity: Up to 150 HD hours 

Hard drive size: 1 TB 

HDMI Video output: 480i, 480p, 720p, 1080i, 1080p 

Power: 12V 

Ethernet port: 10/100 Mbps 

Coax connector 

Optical audio out 

Analog audio 

External storage port (eSATA) 

USB 2.0 port 

Built-in WiFi 

HD antenna (sold separately) TV source 

Internet connection Built-in wireless 

Ethernet port 

Product compatibility Works with TiVo Mini 

Connects to other TiVo DVRs 

iOS and Android app for DVR control management 

Expandable storage (eSATA) 

How to setup 

Connect the antenna 



Connect an HDTV antenna (sold separately) to the A NTENNA port on the back of the DVR. 

2 Connect to your TV 

Connect an HDMI cable from the HDMI port of the TiVo box to the HDMI port on the back of your TV. 

3 Connect to the internet 

Wireless—Select wireless as your networking option during guided software setup and input your routers wireless 
password. 
Note: W ireless is not supported when cnnecting to a TiVo Mini. or 

Ethernet—Connect your ethernet cable from the Roamio OTA 's ETHERNET port to an open port on your router or 
to an ethernet jack in your wall. 
Note: For more networking options, v isittiv o.com/howto.  Before enabling MoCA networking, v isi tiv o.com/moca.  

https://www.tivo.com/support/how-to/how-connect-your-tivo-box-your-home-network
https://www.tivo.com/moca


5 

The TiVo Roamio OTA 's front panel displays a green light at startup. 

4 Plug in the power adapter. 

Go through guided software setup on your TV screen using the TiVo remote. 

Quick Links 

Our Products 

Our Company 

Get Involved 

Sitemap 

Safety & Compliance 

Legal 

https://www.tivo.com/sitemap
https://www.tivo.com/safety-compliance
https://www.tivo.com/legal
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(g) CURRENT CUSTOMERS: Visit MyDish I  Log  In  I Support DishOWINO I  International I DISH For Business I I-Ugh-Speed Internet I  Find a Retailer  I  Watch DISH Anywhere 

d sh VALUE TECHNOLOGY SERVICE COMPARE Call DISH  1-855-839-17110 CHAT 0, 

Upgrade to Hopper wRAM,GriRf3Ift filigVia#1491,0104146tbsEny qualifying package. 

The  Hopper.  The people's choice. 
The Hopper' Whole-Home HD DVR is the award-winning center 

iffe9,4 

d'sh 

.111 

More ry 



Watch this 
record that 

Have more choice Find your remote easier 

More More More 

Pay 
Nothing 

Joey Wireless Joey Super Joey 

Expand to other rooms Put TVs in hard-to-reach areas Record even more programming 

Use a Joey to get Hopper features in any 
room with a wired connection. 

Record your favorite shows while watching 
something else. Add a Super Joey to record 
up to 8 channels at the same time. 

How to enjoy whole-home entertainment 

Learn how you can enjoy a house full of entertainment for friends and family. 
Learn More 

More things our customers love about the Hopper. 

Use a Wireless JoeyTM  to place a TV anywhere 
in your house. 

Enjoy on-demand movies, pay-per-view 
events and FREE Apps when you connect 
your Hopper to the Internet. 

More Features 

Use the Super Joey to add more TV tuners 
and avoid recording conflicts. 

Never lose your remote again! Press a button 
and the Hopper will make your remote beep, 
so you can hear where it's hiding. 



See how the Hopper gives you the power to watch live and recorded TV anywhere. 

Go from whole-home entertainment 
to anywhere entertainment. 

Learn About DISH Anywhere 

Around 
the world 

Critics 
Love Us 

ENTER YOUR EMAIL Sign Up 

"The Hopper is a glimpse into TV’s future..." 
- Reviewed.com  9/30/2013 

Read Full Article 

More Hopper Reviews 

Get the most powerful DVR in the entire world. 
Upgrade to Hopper with no upfront fee on subscription to any qualifying package. 

Get It Now 

Important Terms 

DISH › Hopper 

24/7Customer  Support 

Get updates from DISH. 
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XFINITY X1 FEATURES 

XFINITY TV  X1 Features Channel Lineup Add-On Channels Equipment 

Keep up with Team USA like never 
before 

Experience the Olympic Winter Games 2018 on X1. It's personalized, dynamic, and most of 
all, it's fun and easy to use. 

SPORTS ON X1 

The ultimate sports 
companion 
No matter what sport you're into, X1 is your all-access 
ticket to everything you need to know for the Olympic 
Winter Games. From stats to live coverage, full-event 
replays, and more, it's easier than ever to be fanatical 
about your favorite sports. 

Learn About Sports on X1 

https://www.xfinity.com/
https://www.xfinity.com/buy/
https://www.xfinity.com/learn/digital-cable-tv
https://www.xfinity.com/learn/channel-lineup
https://www.xfinity.com/learn/digital-cable-tv/add-channels
https://www.xfinity.com/learn/digital-cable-tv/x1/equipment
https://www.xfinity.com/hub/tv-video/x1-sports-app-winter-olympics


X1 DVR 

Take your DVR with you 
Watch your recordings from anywhere, even while you're 
offline. Just download your content to any device and 
tune in whenever and wherever you want. 

Record and watch up to 6 shows at once 

Never run out of space with 500GB of storage 

Take your entire cloud DVR library with you 

XFINITY STREAM APP 

More to stream, on any 
screen 
Stream live TV, your DVR library, and Xfinity On Demand 
on any smart device, at home or on the go. All TV, all the 
time, from anywhere. 

Learn About the Xfinity Stream App 

X1 VOICE REMOTE 

https://www.xfinity.com/get-stream


Just say it to see it 
Now you can access recordings with just your voice. 
Simply say "Show me the recordings" into your X1 Voice 
Remote and select what you want to watch. The future of 
voice control is here, and it sounds amazing. 

      

 

00:00 / 00:00 

 

"Show me recordings" 

"Show me Netflix" 

"Watch Sing" 

"Show me Katy Perry" 

Discover your new favorites 
Get recommendations based on what you're watching – even by what's trending on Twitter. 

Search for a title, genre or actor and X1 will search live TV, On Demand, and your DVR 
library. The X1 Guide can even be filtered by your favorite channels. 

SUGGESTIONS TRENDING FAVORITES 

SMART SEARCH 

 

00:00 / 00:00 

 



MORE THAN JUST TV 

Easy access to Netflix 
With X1, you can now watch all your favorite Netflix TV shows and 
movies – without changing inputs. You can even use the X1 Voice 
Remote to find the program you want. 

Learn About Netflix on X1 

NETFLIX  PANDORA YOUTUBE 

It's a game-changing 
experience 
It's all about the numbers – and now you can know your 
stats and learn about the nations, teams, and athletes 
fast, with insightful features like profiles, rosters, real-
time analytics, and much more. 

https://www.xfinity.com/netflix


ACCESSIBILITY 

Bringing the magic of entertainment to everyone 
Learn About Accessibility Features 

Talking guide 
With the talking guide, the visually 
impaired can explore thousands of 
shows and movies independently. 

Voice remote 
The Voice Remote provides 

independence to users with limited 
mobility or visual disabilities. 

Enhanced closed captioning 
Enhanced closed captioning controls 
are built in for those who are deaf or 

hard of hearing. 

SHOP XFINITY 

View all offers › 

X1 FEATURES FOR FAMILIES 

Go ahead, give them the remote 
Worry less about what your children are watching with Kids Zone on 
X1. It's a safe environment where they can watch live TV and 
recordings that are appropriate for ages 12 and under. Content can 
be filtered by age group, too. 

KIDS ZONE  PARENTAL CONTROLS 

HOME SECURITY 

HBO® and related channels and service marks are the property of Home Box Office, Inc. To access Netflix on Xfinity X1 requires an eligible X1 set-top box with Xfinity TV and Xfinity Internet 
service. Limited to Netflix members who are residential customers. Netflix on X1 uses your Internet service and will counts against any Xfinity data plan. Netflix streaming membership required. 

https://www.xfinity.com/accessibility
https://www.xfinity.com/learn/offers#/
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Overview 
With Total Home DVR

®
, you can 

watch over 234 channels in 
brilliant HD

1 
 and record up to 4 

shows at once. New AT&T Fiber 
customers can even get 6 HD 
streams with the ITB Pace DVR. 
Enjoy hundreds of hours of 
programming, and play recorded 
shows from any receiver in your 
home. 

1HD: Access to HD service requires 
$10/mo. Over 234 HD channels 
available with upgrade to U450 and HD 
Premium Tier for $7/mo. 

Record live with one touch 
Save your favorite shows now, and watch them later from any TV in 
your home connected to a receiver. 

Here’s how: 
• Select the RECORD TV button on your remote to begin 

recording your show. 
• You’ll see a confirmation message on your TV. The light on 

your receiver will turn red until you stop recording. 
• Recording ends when your program ends. Want to stop 

recording sooner? Simple select the STOP button on your 
remote, and then OK to confirm. Your show is saved by its 
title. 

   

Welcome Center 

Order & 
Installation 

TV Internet Phone Your First Bill 

Using Your Remote Using Your DVR Shows, Movies & More Resolving Basic TV Issues 

Using your DVR 

Scheduling a Recording 

U-verse features tons of great programs, and your Total Home 
DVR can help you catch all your favorites. 

You can: 
• Record single shows 
• Record a series 
• Set a recording by entering channel, date, and time 

Parental Controls 

Worried your kids might see TV shows they shouldn’t? Use the 
parental controls on your DVR to limit what they watch. 

Control access to: 
• TV shows and movies by rating 
• Pay Per View & On Demand purchases 
• Adult programming 

Chat available 

Access Favorites, Parental Controls & More on 
U-verse TV 

2:13 

U-verse DVR Features - Set Up, Schedule & Record TV Shows | AT&T Page 1 of 2 

Welcome Center  /  U-verse TV  / Using Your DVR 

https://www.att.com/u-verse-welcome/tv/dvr.html 2/1/2018 



Looking for additional information? 
If you are looking for more detailed information related to your service and equipment, here are some additional resources that will 
help you get the answers you need. 

Troubleshoot & Resolve 

Access customized solutions from 
your PC, mobile or tablet device and 
get your AT&T service back up and 
running. 

Launch Troubleshoot & Resolve Tool 

Online Support 

Connect with a service 
representative, and get assistance 
with your U-verse TV service. 

Contact Us 

User Guides 

If you're looking for quick answers or 
want a little more info about your 
equipment, user guides are a handy 
way to find what you need. 

View User Guides 

U-verse DVR Features - Set Up, Schedule & Record TV Shows | AT&T Page 2 of 2 

Chat available 

https://www.att.com/u-verse-welcome/tv/dvr.html  2/1/2018 
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Sign In 
My Account Shop  Support  Learn 

Residential Cox Business Español Shopping Cart Contact Us Saint Louis, MO 

TV 

Back 

Contour 2: DVR 
Never miss a show again. Follow these tips to learn how to set 

up your Contour DVR, manage your settings, and record 
shows. 

Watch TV in Any Room 
Watch recordings on any TV in the house with Whole 
Home DVR and the Contour mobile app. You can 
even start watching in one room and finish in 
another! 

Record Multiple Shows at 
One Time 
Now the whole family can record their favorite shows 
at once. Record up to six shows at once with the 
Contour Record 6 DVR or up to two shows at once 
with the Record 2 DVR. Schedule a program, series, 
personality or sports team to record and specify 
record options to end a recording late, record only 
new episodes or choose channel preferences (like 
HD). 

Store Hundreds of Shows 
Enjoy plenty of storage space so you don't have to delete your favorite shows to make room for new ones. The 
Contour Record 6 DVR has a 2 TB hard drive that allows you to store about 1,000 hours of SD programs or 250 
hours of HD programs. The Contour Record 2 DVR allows you to store about 200 hours of SD programs or 100 
hours of HD programs. Easily access all of your recordings or prioritize your series by selecting Saved on the 
Contour menu. 

http://www.cox.com/residential/home.html
http://www.cox.com/business/home.html
http://espanol.cox.com/
https://www.cox.com/residential-shop/shoppingcart.cox
https://www.cox.com/residential/contactus.html
https://www.cox.com/residential/home.html
https://www.cox.com/residential/education-center/home.html
https://www.cox.com/residential/education-center/tv.html
https://www.cox.com/residential/education-center/internet.html
https://www.cox.com/residential/education-center/phone.html
https://www.cox.com/residential/education-center/homelife.html
https://www.cox.com/residential/education-center/getting-started.html
https://www.cox.com/residential/education-center/tv.html


Watch a Recording 

The Contour 2 DVR allows you to watch your saved 
recordings at the time that is right for you. Follow the 
steps to watch a saved recording. 

Press the Contour button on your remote 
control. 

1 

In the menu, scroll to Saved using the Left 
Arrow and Right Arrow buttons on the 
remote. Press the OK button on your remote 
control. 

Use the Up Arrow, Down Arrow, Left Arrow 
and Right Arrow buttons on the remote to 
select a recording, and press OK on your 
remote control. 

Scroll to Watch and press OK. 4 

Pause or Rewind Live TV 

2 

3 

Record a Program 

Highlight a program on the Guide screen. 1 

Select the Record button on the remote 
control, or select the Record option on 
the program's info panel. 

Select Just This Episode, and the 
recording will be set. 

3 

Record a Series 

Press the Guide button on the remote. Select 
a program and press OK on the remote. 
Highlight Record and press OK. 

Highlight All Future Episodes and press OK. 
Highlight Confirm and press OK. 

2 

1 

2 



1 

2 

3 

4 

With your Contour DVR, live TV works just like a recording. Pause what you are watching, rewind it and advance 
back to live TV using your remote control. 

Select the Guide to view live programming, select Favorites and schedule recordings. 

Record up to six shows at once with the Record 6 DVR and access them from any room in your home. 

Pause, rewind or fast forward recordings using the remote. 

Modify your recordings and prioritize based on your favorite shows under Scheduled in the Saved folder. 

Playback Controls for Live TV 

Access playback controls for live TV with the Down 



Access playback controls for live TV with the Down 
Arrow button. Press the Down Arrow twice, then 
use the Left Arrow and Right Arrow buttons to 
choose a control: 

Go back to the beginning of the program 

For live TV, go back to the beginning of the live TV 
buffer—the last 90 minutes of a standard-
definition channel or the last 30 minutes of a high-
definition channel. The buffer begins when you: 

Go back and ahead five minutes 

Rewind, play/pause, fast forward 

Turn Closed Captioning (“CC”) on or off 

Go back to live TV (what is broadcasting on a 
channel now) 

To Pause Live TV: To Fast Forward: 

Press the Play/Pause button on the remote to 
pause the program you are watching. Press the 
button again to resume watching. 

To Rewind Live TV: 

After you have rewound live TV, you can use the Fast 
Forward button to fast forward to a later point in the 
program, all the way up to what is broadcasting live. 
Press the Fast Forward or Rewind button multiple 
times for super fast lightning mode or use Page Up 
or Page Down to skip ahead or back 5 minutes at a 
time while watching live TV. 

Rewind button 

The DVR creates a buffer of a channel you are 
watching as long as you remain tuned into 
that channel. You can rewind up to 90 
minutes of standard-definition programming 
or rewind up to 30 minutes of high-definition 
programming. The buffer begins when you 
start watching a channel. 

To Return to Live TV: 

After you have paused or rewound live TV, you can 
return to what is broadcasting live by pressing the 
Exit button. 

When you have reached the point from which 
you wish to start watching, press the 
Play/Pause button 

Note: You can also use the Page Down button to skip five minutes 
back while watching live TV. 

Record From Anywhere 
You can also schedule a program to record from 



anywhere using TV Listings on Cox.com  or in the Cox 
Connect app. Just go to  TV Listings  , click the show 
you want to record, and follow the prompts to set a 
recording. 

GO TO TV LISTINGS GO TO DVR SUPPORT GO TO REMOTE GUIDE 

See  Contour TV service details  . See also  Contour TV Purchased Content  details. Netflix is available in select countries. Streaming membership required. More information at 
www.netflix.com.  See important information in the  Residential Customer Service Agreement  for full coverage details. See  Annual Notice information  for related information 
and your privacy rights as a Cox customer. See also the  Annual Customer Notices  . See important  Cox Digital Telephone Power Outage  usage information. For all Cox 
Communication policies regarding our services and business practices visit www.cox.com/aboutus/policies.html.  

View & Pay My Bill 
Manage My Account 
Use My Services Tools 
Check My Cox Email 

I want to... 

© 2018 Cox Communications, Inc. 

a Cox Enterprises Kudzu Customer Privacy Rights Policy/Legal About Our Ads 

Watch TV Online 
TV Listings & Recording 
Get Cox Apps 
Get Help With My Services 

Bundles & Promotions 
Contour & TV 
Internet 
Home Phone 
Homelife 
All Pricing and Plans 
Multi-Unit Buildings 

Shop About Cox 

About Us Home 
Newsroom 
Take Charge! 
Careers 
Contract Positions 
Areas We Serve 

Diversity 
Converge Blog 
FCC Public File 
Supplier Relations 
Advertise with Us 
Find a Store 

Feedback 

Schedule a Recording DVR Support Remote Control Help 

When you’re away from home, Visit Cox Support for more help with Learn more about the features, setup, 
schedule a show to record through setting and troubleshooting DVR and use of your Cox remote control. 
the Cox.com  TV listings. recordings. 

http://www.cox.com/myconnection/watch/entertainment/tv-listings.cox
http://www.cox.com/myconnection/watch/entertainment/tv-listings.cox
https://www.cox.com/residential/support/tv/articles/dvr-recording.html
https://www.cox.com/residential/support/contour-2-xr11-voice-remote.html
https://www.cox.com/residential/purchased.html
https://www.netflix.com
https://www.cox.com/aboutus/policies/customer-service-agreement.html
https://www.cox.com/aboutus/policies/annual-privacy-notice.html
https://www.cox.com/aboutus/policies/annual-privacy-notice.html
https://www.cox.com/aboutus/policies/phone-modem-battery-policy.html
https://www.cox.com/aboutus/policies.html
https://www.cox.com/ibill/home.cox
https://www.cox.com/resaccount/home.cox
https://www.cox.com/resaccount/tools.cox
http://webmail.cox.net/
https://www.cox.com/residential/tv/watch-tv-online.html
https://www.cox.com/myconnection/watch/entertainment/tv-listings.cox
https://www.cox.com/residential/tv/tv-apps.html
https://www.cox.com/residential/support/home.html
https://www.cox.com/residential/special-offers/bundles.html
https://www.cox.com/residential/tv.html
https://www.cox.com/residential/internet.html
https://www.cox.com/residential/phone.html
https://www.cox.com/residential/homelife.html
https://www.cox.com/residential/pricing.html
https://www.cox.com/residential/mdu-community.html
https://www.cox.com/aboutus/home.html
http://newsroom.cox.com/
https://www.cox.com/aboutus/take-charge.html
https://www.cox.com/aboutus/careers.html
http://www.zerochaos.com/cox/index.htm
https://www.cox.com/residential/locations/areas-we-serve.html
https://www.cox.com/aboutus/diversity.html
https://converge.cox.com/
https://www.cox.com/residential/fcc-regulatory.html
https://www.cox.com/aboutus/suppliers.html
http://www.coxmedia.com/contact.jsp?navigation=7
https://www.cox.com/residential/retail.html
http://www.coxmedia.com/
http://www.coxenterprises.com/
http://www.kudzu.com/
https://www.cox.com/aboutus/policies/annual-privacy-notice.html
https://www.cox.com/aboutus/policies/online-privacy-policy.html
https://www.cox.com/aboutus/policies/online-privacy-policy.html
http://www.youtube.com/user/CoxCommTV
http://instagram.com/coxcommunications
https://www.facebook.com/coxcommunications
https://twitter.com/coxcomm
https://plus.google.com/u/0/+coxcommunications/posts

